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Chapter 1 Installation

System Requirements

Operating system:
MediaCreator is designed to run under Windows 95, 98, NT, 2K, ME, and XP. Y ou need
one of these operating systems on your computer in order to run the program.

Processor (CPU):

MediaCreator will run only on a 486 or higher processor. A Pentium (or higher) is
strongly recommended.

RAM:
Minimum recommended: 64MBytes

Hard Disk Space:

Y ou must have a minimum of 160 Mbytes of Hard Disk space to run the program. If you
intend to create many Background Graphics, or save alot of pages, make sure that you
have enough Hard Disk space available

CD-ROM:

If you intend to install the software from a CD-ROM |, the system must have a CD-ROM
drive.

VGA Card:

The VGA Card must be set to either 16-bit color or higher. If you run your VGA card in
High Color mode, color gradients may not appear smooth on your VGA monitor. This
will not affect the quality of the graphics that the MediaCreator and MediaXtreme
produce. They should appear very smooth in 24 or 32 bits per pixel mode. MediaCreator
will not run if the VGA mode is set to 8-bit (or less) color.

Installing the Software

MediaCreator has a Setup program to help you setup the software to run on your
computer.
Windows must be running before you can install the MediaCreator software.

Insert the MediaCreator CD-ROM into the CD-ROM drive. If the MediaCreator Install
window does not automatically appear after afew seconds, run the“SETUP.EXE”
program from the CD-ROM. The system will begin installing the software. Follow the
instructions on the screen until the software is completely installed. A folder named
MediaCreator should now be in the Programs menu. There should also be an Icon
called MediaCreator on your desktop.

Keywest Technology 6
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Chapter 2 Introduction to MediaXtreme

The MediaCreator software is used with the MediaXtreme to create and display high-
quality information display sequences. The capabilities go far beyond that--sports score
box overlays, text crawl overlays, Picture-in-Picture, and much, much more. It'sthe all-
in-one answer for information display!

MediaCreator User Interface

If you don’t have the software installed yet, follow the directionsin chapter 1. Start the
MediaCreator just as you would any other program under Windows. After afew seconds
the MediaCreator application will appear. The software automatically adjustsits
windows to fit your screen.

Starting Up
Click on the MediaCreator 1con on your desktop, or access the program through the start
menul.

MediaCreat. ..

Typical Icon

Lﬁ Arcessories
Eﬁ Micrografx Designer
Docurments 4 ﬁ Mo~ BUrring Rom

Programs

’ @ Symantec pAnywhers

E
o
2

Settings kol
U= MakeCDROM
Search r E Media Creatar
S Hypersnap-D¥ 4 ,
Help (=} Microsoft Speech SDK 5.1 » b |
. .
Typical Start Menu Appearance
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The main program “Splash” screen will appear, click on the MEDIA CREATOR button
to start the application.

| " Media Creator v.3.0.4

Sart-up Splash Screen

Serial Numbers & Passwords

MediaCreator is a password-protected program. Y ou must register your software within
30 days of installation, or it will cease to operate. Thefirst time you click on the MEDIA
CREATOR button, or any subsequent time while not registered, you will see a
“REMINDER” window discussing registration, and giving you access to enter the
Registration Key. Thisreminder may first appear in your task bar at the bottom of your
screen.

star| | 71| @ (53 ) ”U [Biligaseudy Lt indon | % e Gostorv30 [[Reminder {@es 80 os
Typical Task Bar
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Click on the “REMINDER” button on the task bar—Y OU WILL NOT BE ABLE TO
ACCESS MEDIA CREATOR UNTIL YOU DO! Y ou will now see the reminder and
registration window.

Remnder x

vour copy Media Creator Softivare iz nok registered,  Thizis a
Creator that will expire in if wou do not reqister it Fle
Technalogy at 1-800-3371-2013 ta regizter over the phong or gocto wisw, med

register online.

LCrea

=
Visiwebsia | Enterkey | ok |

Registration Reminder

Here you have two choices. You could just click OK, and NO on the following screen,
and continue to operate unregistered for the first 30 days, or you could call Keywest
Technology at 800-331-2019, or visit www.mediaxtreme.tv and register your software.
Registration gets you access to the program, but also activates your telephone support
access. You will not be able to access telephone support unless you are registered!

After you click OK, you will see the actual registration screen.

nterkey x|

Enter the registration name and key below, exactly az given to
WLk, : :

Hardware fingerprint; B330-8CE3

I arie: I
Foa I

ok | Cancel | isit Website

Register Key Screen
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When you call Keywest Technology to register, or access registration via the Website we
will ask you for your registration information, registration name (this can be anything you
want it to be—it doesn’t have to be the actual name you register the software under for
tech support) and the Hardware fingerprint produced by your machine (as shown above).
We will use that information and generate a unique Key for you immediately. Once you
enter that key, you are registered, and you will have unlimited functionality.

Running MediaCreator

Now that you've installed and registered your MediaCreator software, you' re ready to get

creativel

The application should open.

“Eeywret Technology - Mecdia Creator - LinkiHed . - !:i
Fim b Wy  Alibules Movs Tat Sstnp. Proves - Comnuneshire - Hop
Sl=im] 2] Rl | {sel=ded Tea -] EElaisia] |
Backoimiid-hime. | Waistkes | WideoWwisdsd | CVeleeWindewEdw Do | Faue Skwiee |
Tasd | s T | Peiibonnpg ' Al Bpacig Lenos I Euctpmral » Dol Broess - |
Dunacter T e Liat - — dar |
= . IR | I Dt
% raie | mincemnnennovs] | Al K & A 5 |
AA M Bl M T ppefiaces - | 1 _|!!
e s | T ﬂ| :|
"'_; fio0: == Clmgt Handies; OFF ! :—l | I_:. = |l
| | eserine rar e —J g _II vl :'.J
MediaCreator Application
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MENUS

il Edil  Wiew Abttribiit=s  Mdvs Tl

MediaCreator Menu Bar

The menu bar (shown above) isjust what you expect in a Windows program: it hasa
File entry that is used to open, create, and save, the types of files that MediaCreator can
open, create, and save (pages and proj ects).

The Edit menu is used for the normal Undo, Cut, Copy, Paste, Insert, Delete, and Erase
functions.

The View menu is used to display or hide the various windows.

The Attributes menu is used to adjust the various text attributes.

The Move Text menu has commands for Word Wrap/Unwrap, Centering, Justifying,
and Positioning. It also has a command to let you adjust the Row Leading.

The Settings menu is used to setup your system. These include things like Setting User
Preferences, Load Typefaces, Set Tabs, Adjust Safe title Margins, set the page to Lower
Third mode, and setting your default folders/directories.

The Preview menu is used for a Creation Station preview of your current project. This
preview will play on the computer you are using to create the pages. It will not contain
the dwell times or transitions that you have programmed. Rest assured, those will appear
on the MediaxXtreme player just as you designed.

The Communications menu item is the business end of the menu bar. Thisiswhere
you connect to the remote MediaXtreme player; send emergency messages, send
schedules, send pages, and other maintenance functions. Thistab is covered in-depth in
later pages.

The Help Menu is currently not available. For help, go to www.mediaxtreme.tv .

TOOLBAR

|5t:|t:ctt:d Text

MediaCreator Toolbar

The Toolbar (shown above) is a quick way to access common functions. These include
commands from the File menu such as Create New Page, Open Existing Page, and Save
page. Cut, copy, paste, and undo functions from the Edit menu are included on the
toolbar.

The toolbar contains a mode selection box that defaultsto “Selected Text”. This
determines which text will be modified by a command such as select font. The options
include such things are Selected text, entire word, entire row, and entire page.

Keywest Technology 11
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To the right of the mode selection box are some buttons that Center and Justify the page.

XTREME PAGESMANAGER
 FiFS_demo

The Xtreme Pages Manager gives you quick access to all of the pagesin your system.
When a Page is saved, athumbnail is created. These thumbnails, along with the name of
the page are displayed in the Xtreme Pages Manager. To open apage, just click on its
thumbnail.

Keywest Technology 12
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CREATOR WINDOW

The Creator window is where you compose your pages. To enter text in this window,
point the mouse to where you want the text to appear, and click the left mouse button. A
rectangle appears where you clicked the mouse. Thisisthe text cursor. It showswhere
text will be entered. Type some text and it will appear at the cursor position. This
window is also where you will import your backgrounds, other graphics, and images.
Thisisthe window in which you'll make your information display cometo life.

ElSSISESE Or e 1 P Bt Pt o o B

[

d Ted | i | Prterin | i B | R <M ] Bkt mais | s Wis | Pt s

SHORTCUT BUTTONS

The Shortcut Buttons window contains buttons of frequently used functions. They are
placed in this handy position so that you can just reach over and easily press one of these
buttons with the mouse.

Fedraim
Page

Export
Fage

Heset
Fom
Spacitg

Center
R o

Center
Fage
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PRESET STYLE GALLERY

MediaCreator can display up to 64 preset text styles. These are text styles that will
probably be used frequently. You're not limited to only these 64 styles, they are only
there as shortcut to the styles that you use most often. Y ou can scroll through the preset
text styles, and select one by clicking onit. When you select a new style from the Style
Gallery, all selected text will be set to the new style. After the new preset text style has
been selected, any new text that you enter will appear in the selected text style. You can
change these preset text styles to be whatever you want by right clicking on one and

selecting “set style”
a

Al

CONTROL TABS
MediaCreator text settings controls are numerous, and are divided into groups. These are

on asingle Tab form. Simply select the appropriate tab for whatever adjustment you
need to make.

Texl | olors | Posining | Fiow Spacing | Logos | Backgroting - Colors | Backgrund - Imags | Page Transiions |
— Eharacter —Edae:

. lipefaee
! —Direch
[ ltshcize [pauss fand | A| .ll ‘_I I _]mc mn_[ _1
S "__._I\'"ﬁﬁ_" --;PEE‘:&];-- — Blur-—
WAL e |l 0 o A
oo 4t i ™
|1”” »%|  CursorHandes OFF T Im 2 Inm i e
snanlings LR soanlines
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This tab lets you change the Height, Width, Italics, and Typeface of the character. Itis
also used to select the Type, Depth, Direction, and Blur of the Edge. The text size and
position can aso be changed by clicking and dragging the cursor handles. Y ou can turn
the handles on and off.

The Edge can be any of the following types:

?? No Edge

The edge does not appear.

?? Full Surround

The edge surrounds the character equally on all sides.

?? Extruded

The character is extruded to give the character a 3D |ook.

?? Highlighted

The character is extruded with anarrow full surround border to highlight the character.
?? Offset

The edge is offset asif it is casting a shadow.

The depth and blur of the edge of each character can be set separately. If the selected
edge typeis Extruded, Highlighted, or Offset, the direction can be set to any of the 8
directions.

Clicking on the “Depth” icon and dragging the mouse will change the edge depth.
Clicking on the “Blur” icon and dragging the mouse will change the edge blur. The text
will be redrawn with the new values as you drag the mouse.

Colors Tab

Teat Calors |F'n§:iﬁcr'r_1ii"1§| HD&\;SDEQ]J;!Q! Lngl:lai Ela-:kg.tnurjd—'Emer_ecI Eackmnu_nd—l'magq.i Fage Tra_nsitiu;unsi

Calar | .
_ ¥ TopColar Trans:
Ehiaisctar Sli ) e I

I assl Ir&' Blottom Colot . ﬁ

Palette | ——————— '\«"'d
Edge =
- Gradient iﬁgﬁ%» : ID -
- Pick Color —

Teshres from Screen

The Colorstab lets you change the color of the Character, the Edge, and Shadows. On the
left there is agroup of boxes that display the current color of each component of the
character. The box below it shows the color of the current component.

To change the color, select the component to change (Character, Edge, or Shadow) then
use the controls on the right to select the color. There are five ways to select a color.

Y ou can use acolor picker, color dliders, select a color from a preset palette, set the color
to agradient, or set the color to atexture.

Select one of the 5 buttons to choose which method to select the color.

Here are the different methods you can use to select colors:

HidR
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?? Color Picker

?? Color Sliders
?? Color Paette
?? Color Gradients
?? Textures
Color Picker
[EElEET .
| |\¥ TopEolor
Sliders
p— ™ Bottorm Calor
Palette |-
| Biadiant . -
| PickCalor
Testures. from Scresn,

The color picker lets you select a color using avisual approach. Y ou can set the top and
bottom colors separately. If the top and bottom colors are different, the Character, Edge,
or Shadow will be drawn with a smooth color spread between the top and bottom. One of
the controlsin this box is used to select the Hue (red, yellow, green, blue, etc) of the
color. When anew hue is selected the other color box will change to reflect the new hue.
Y ou can select any color from this box just by clicking the mouse on the desired color.

Y ou can aso vary the Transparency and the amount of External video levels that the text
component will be drawn with. Transparency will let whatever is behind the component
to show through. Setting the Video Level draws the component with a mixture of
background video and a color. The higher the video level, the more dominant the
background video will appear.

The“Illegal Color Indicator” will appear red if the selected color isanillegal NTSC or
PAL color. It will appear greenif alegal color is selected.

Sliders

Picke |

it Ll el Hue: __I_ g

25 [ef=ie " RGB : i !

— | ¥ Botiom Calor L | f——— [0 |

il — - =

——— I - el e e .51199 |

Gradient | = T | B |

Tentures Tmn_;;_| 0 ’E_ Videa| | — [

The color dliders et you select the color using anumerical approach. Y ou can choose
whether you want to define RGB (red, green, blue) values or HLS (Hue, Luma,
Saturation) values. The top and bottom colors can be set separately. If the top and

Keywest Technology 16
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bottom colors are different, the Character, Edge, or Shadow will be drawn with a smooth
color spread between them.

Y ou can also vary the Transparency and the amount of External video levelsthat the text
component will be drawn with. Transparency will let whatever is behind the component
show through. Setting the Video Level draws the component with a mixture of
background video and a color. The higher the video level, the more dominant the
background video will appear.

The“Illegal Color Indicator” will appear red if the selected color isan illegal NTSC or
PAL color. It will appear green if alegal color is selected.

Palette
Ficket :
i [~ Top Colar
Sliders o
———| ¥ Bottam Color
e _

=

Testures | BackooundVidea| ™= b Prol o anw Color button to modify i

Y ou can select any of the 64 preset colors from the color Palette. The top and bottom
colors can be set separately. If the top and bottom colors are different, the Character,
Edge, or Shadow will be drawn with a smooth color spread between them.
The“Illegal Color Indicator” will appear red if the selected color isanillegal NTSC or
PAL color. It will appear greenif alegal color is selected.

Y ou can also select Background Video as the color just by pressing the “Background
Video” button. To modify the color palette, double click on the entry that you want to
modify. The Color Palette Editor will appear. Thislets you change the color of each
palette entry.

Gradients

Picker
Sliders
Palstte

[ ][t

Testures | Dauible Click o any Color Gisdient to modiy it

Each project in the MediaCreator can have as many as 64 preset color gradients defined.
They can be either linear gradients or areagradients. A Linear Gradient can have up to
16 color points and can be rotated up to 90 degrees in either direction. An area gradient
can set each corner to adifferent color and the colors will create a smooth blend between
the colors. A center color point can also be added to create a 5-point color gradient. The
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center point can be positioned anywhere within the color gradient. Thisisvery useful for
creating highlighted colors.

Y ou can modify acolor gradient by double clicking on the one you want to modify. The
Color Gradient Builder will then appear. The Color Gradient Builder can then be used to
select the type of gradient, as well as the color and position of the pointsin the gradient.

Textures

Fiska  SNENEENENES
_ b, ,|||||';?||||||E_|||uﬁnnrz—l|||||§|:u :
Sliders ElEIENEINENE
— = ENEINETES
Palstte = =l |—J|J|;:JII.._||I-—IJ|J|-: :
e EMEIENETEL
Gradient | = ENENENENE
= : HIENENENEE=

et Double Click on anp Teuture to madify it

The Textures button lets you apply atexture to any of the text components (Character,
Edges, or Shadows). Select any of the loaded textures by clicking the mouse on the
desired texture. There can be up to 8 textures loaded for each page. Any JPG, GIF, TIF,
TGA, BMP, or PCX image can be used as atexture. To load a new texture, double click
on the position that you want to load it into, and then select the image that you want to
load as the new texture.

Positioning Tab

Test | Colore ~Positioning |H;:~_v~15paqlﬁg! Logos | Backgraund - Colors | Background - Imags | Page Transiiohs |

Wm&W:apr‘thr;p — ey — = _Pagﬁ_‘b = F'.usﬂlzrr:’uf'fﬂ _.3_
3 — Fo _ .
e T L I e — q’
£ ] - T e — _>=<_ ¢ .. : _Fi._eﬁel',
= == === = w Text
— v Positicn

The Positioning tab has the buttons that are used to Wrap and Unwrap words, Centering,
and Justifying rows, entire layers, and entire pages. The text can also be fine positioned
by using “Fine Positioning” buttons.

The text can also be positioned by dragging the Movement cursor handles with the
mouse.
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Row Spacing Tab

Test i Dulnrgi Positioning  Row Spacing ||-.':'!E|‘-'-'3»'I Ea-:kgmur}(d—'ﬂblg:r_;l ankmnu_h_d—l'magq.i Page Tra_nsiti';lhsi

—Changs Fow Spacing of- Lesz Mare
¢ ErlisPags Sl Defaut o Specing |

These controls are used to change the row leading (spacing) of the cursor row or the
Entire page.

Background - Colors Tab

T et | Colors i Pozitioning | Fiow Spacing | Logos: Backaraund -Et!l_t"ﬂ-l Backaground -|mage | F'agaT'{ansi'[ionsl

| F —
Cofor Box v Top Calor Trans:
Fursaeen | | [ s | | o &
Backibind ol e [¥ ' Bottom Calar =
- H
E'EJ‘EEBEEZ}:RQ&M ; EI_I Wideo:
AR, Gradient I |EI Al
¥ e | Fick Eolor :l'J
—_— Texlures Iror Seiean

Background color boxes can be added to the page. Y ou can apply a solid color (with
Transparency and Background Video) or you can apply acolor gradient (linear, 4 point,
or 5 point). You can even apply atexture to a background color box.

As many as 32 color boxes can be placed on each screen. The layering order of

background color boxes can be changed.
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Background - Image Tab

Tewt | Colors | Positioning | Row Spacing | Loaos | Backamurid - Colors - Backarotind - Image: | Page Transitions

Curient Backoround Graghis Iriage:
[CAREG_RFSABITHAR S now. BMP

Mo Graphic

: i Select Mew
[B ackground Video|

Background Graphic

A JPG, GIF, TIF, TGA, BMP, or PCX image can be loaded as a background Graphic.
When a background graphic is loaded, it will be displayed centered on the screen. The
MediaCreator will give you optionsto fill the Creator window with the background
image, or useit in its native size and resolution.

If you select the “No Graphic” button, no background graphic will appear.

Video Window Tab

Texl l Ecllors'l Pmsjtioningl R Spacingl B'ackgruund-EuInrs'l Background - lmage  Yidso \Window F'age.f-\ttribul;esl

— Backarovnd Yideo Window-
‘Mo : " Full Scrmen
Brackarourd aﬁ??hl—e Yideo Background
Video L Videno

This tab allows you to select a background source of video, or a scalable video window.
These features are only useful if you have the PiP and/or Keyer optionsinstalled in your
MediaXtreme. If you don’'t have these video features installed, choosing video as a
background or a scalable window, will result in smply a black window on your display
background. Scalable video window gives you a box on the Creator window, that you
resize according to where and how large you want your video to play. Thisautomatically
sets the integrated Picture-in-Picture board to display scaled video as you’ ve commanded.
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Video Edge Color Tab
[N ="18 1 L 1 (RS ENTALSI RTINS 1 (RS S T (R R 1 L L 1 LT P ST P ™ L] L LS S 1
EI'é_EEEgr_auﬁd'- Image | “arables | iden Windan Wideo window Edge Colar | F*'éi.gé.:,ﬁ;f_:[-ijlj.uﬂ_g's_g_ |

Bicter _ Fo—

Sliders: : 4

——— v Baottani Color - ; _I':' ﬁ
Falette
T llegal © et
Gradient ||:| o

' Pick Calar -

Textures | from Sereen

If you' ve purchased the PiP option, and you' ve made a page with a PiP window, you can
access the Video Edge Color tab and border your video image with colors, textures
(pictures), or gradientsjust like anormal color box. On the Video Window Edge Color

tab, you select your edge color or effect.

Next, select your Video Window Tab again, and you can adjust the size and further

effects of the video edge.
2]
|

Resst
Row
Spacing

Center
&l.

Center
Page

Ascditioral
Teme
Featurss

Fiisidis

F Background - Color Boxes
Varizbles VideaWindow | Video Window Edge Color | Page Attibutes

Temt I Colars | Postioning | Fow Spacing | Logos: |

Background - Imags: |
T kg Vides Wik B
—
. - || AR A& AT
S S calableVider ||| £l acisen == el s e -
Wind i Background Dy ]
.\

o

Backgrotnd

Video Video

e

Mairtain Aspect Fatio

Keywest Technology 21
www.keywesttechnology.com
800-331-2019 (USA)




MediaCreator Software Operations Manual 290ct03
Keywest Technology MediaXtreme System rev4

For our example above, in the previous illustration, we' ve used a texture to border the
video window. Notice the controls under the Video Window Tab that are copies of the
Text shadowing controls. We do this for familiarity—the shadowing functions for the
video window just asit doesfor text. You can size it with the Depth function, Blur the
border, change the type and angle of the shadow (or, if you prefer, the edge color).
Experiment with it and see what you can do!

Page Specific Logos

MediaCreator and MediaXtreme v3.x.x are capable of inserting not only logo’s over an
entire schedule, but can also insert them into a crawl, or a specific page. Click on the
LOGOstab to seethisin action.

Backgiound-Image | arisbles | Videoindow | Videolindow EdgeColor | Pagsatributes
Tet | Colors | Posoning | FowSpacing Logos 1 Backarouid - Color Boses

Logo Narne:
Cursor is hot on aloga

Mai Height{| Scariines

Set to Maximum Size:
M mw' Tﬂ!-l*ﬁln— F'ME

From here, you can click on ADD NEW LOGO. A browser window will open allowing
you to select your logo. Once you'’ ve selected one (and it can be alogo, or afull screen
pictureif you like—although, it will only fill a maximum size of %zthe screen).

Sotharmand- o | Vambise | WideoMindon | VidmWndorEdeeCoiw | Pasedmbes
Ted | Cokee | CPodioeim | RowGgecng * Loigm Beckomrd - CakbiBoues

. Ll

| [
Lega ‘

N —

m}.# A _m Zad 1o M T Sen I
Mgvman W] i
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To change size or other attributes of the page specific logo, you must access the TEXT
tab, and turn on CURSOR HANDLES to click and drag resize. Y ou can aso use the text
size and width text boxes to change the Logo Size.

Y ou may aso use page specific logosin your crawls. Simply drag and drop as you
would on anormal page!

TR

2 e e < B P

Resized Logo Image

STATUSBAR

For HE]R{:'FT.@%,S':F'I [Layer: Teat in\"ﬁn"\mfe [Fowe 1 Cole 1

The Status Bar (shown above) at the bottom of the screen displays the current status of
the program. Itisdivided into 4 panes. Thefirst pane displaysaoneline HINT about
the Toolbar button or Menu entry that the cursor is currently pointing to. The next pane
shows the name of the current layer. “Text” isthe only layer available in the
MediaxXtreme. The third pane shows the current typing mode (insert or overwrite). The
last pane displays the current row and column position of the cursor within the page.
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Chapter 3 Communications, Creating, Editing &
Scheduling

SETTING UP COMMUNICATION TO MediaXtreme

CONFIGURING MEDIAXTREME FOR NETWORK COMMUNICATIONS

MediaXtreme must be properly configured for the network environment in which it will
work. After MediaxXtreme is configured, a new Remote Location can be created that
allows the unit to connect to the network.

Configuring MediaXtreme

To configure the MediaXtreme display unit for network communications it is necessary
to have a PS/2 keyboard and mouse aswell asaVGA or NTSC monitor.

To Configure MediaXtreme:

1. Power down the unit by either pressing the power button or disconnecting the power
cord.

2. Connect the keyboard, mouse and VGA or NTSC monitor to the unit and then power
the unit back up.

3. Once the schedule begins displaying, press and hold the “q” key twice and the
schedule will exit--the standard Windows98© desktop appears.

4. Right click on Network Neighborhood and then select Properties.

The Network window comes up.

6. Highlight TCP/IP and then click on the Properties button.
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The TCP/IP window comes up.
Network E1x] TCP/IP Properties [Z]x]
Configuration | Identificationl Acoess Eontroll Bindings I Advanced I hetBl05

The following network, components are installed;
Client for Microsoft Metwarks

88 |ntel 32558-based Integrated Ethemet with W ake on LAN
[§ MetBEUI

DMS Configuration I Gateway | WIMS Configuration P Address

An IP address can be automatically azzianed to this computer.
If pour network, does not automatically aszign IP addresses, ask
wour netwark administrator for an address, and then type it in
the space below.

!B\ File and printer sharing for Microsoft Metworks

" Obtain an P address automatically

Add... | Remove | Froperties | =]
Frimary Hetwork, Logon: IP Address: | 12 0 TR |
I Client for Microzoft Mebwaorks ﬂ : - : -

Subnet Mask: |255. 0.0.0 |

File and Frint Sharing... |

Diescription

TCR/IP iz the protoceol yau use ta contect to the Intemet and
wide-area nebworks.

0K I Cancel | OE, I Cancel

Default values appear in the TCP/IP window.
A knowledgeable networking person should input the correct values so that
MediaXtreme can communicate over the network.
We recommend the MediaXtreme be givenaSTATIC IP ADDRESS (so you
can find it from anywhere in the world! Just watch out for firewalls—see your IT
person). DHCP is supported.

7. Click OK after the TCP/IP settingsis correct.

The Main Network Settings dialog will come on screen.

8. If thereisonly one MediaXtreme attached to the network, click the OK button again
and follow the on screen directions.

If there are multiple MediaXtreme units on the network, it may be necessary to
change the computer name. See your IT person for this task.

Once MediaXtremeis properly configured for network communication, the new
Remote L ocation can be defined using the TCP/IP addressasthe |P Addressin the
new remote location dialog box.

The first thing that should be done once the system is installed and the program is loaded
and running is to define the MediaXtreme as the Remote Location. Remote Location is
the term used to identify the MediaXtreme that the PC is talking to. Remember, your
computer with the MediaCreator software is the creation station that sends its information
to the MediaXtreme display unit (the hardware). Y ou can have one REMOTE
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LOCATION or many. Each unit will be given aunique name. Only one unit can be
connected to at atime.

Defining a New Remote Location

To Define a New Remote Location:
1. Select the Communications Menu on the menu bar.

ﬂ = & Location

Edit Remate Location

The Communications drop down window appears. F?_””EC‘
2. Select New Remote Location. o s

The New Remote Location window appears.

v v v ¥

Keywest Technology 26
www.keywesttechnology.com
800-331-2019 (USA)



290ct03
rev 4

MediaCreator Software Operations Manual
Keywest Technology MediaXtreme System

3. Type in a name for the Remote Location in the field at

the tOp of the window Mew Remote Location

" Location Name

The name will be how the unit is referred to by the
system. Use a hame that makes sense for the
installation, especially if there will be multiple
units used.

4. Select the connection type used for the unit in the
Connection Information area, Serial, Modem or
Network, and specify its settings.

When a Connection type is selected its
information fields are activated.

For Serial and Modem Connections the typical
comport or serial port used is COM 1. Ifa

Enter a name for the new location. There iz one
schedule per remote location. When opening a
connection to a remote dizplay unit. it will be
referred to by the name you supply below.

" Connection Information

® Serial Connection
Port Baud

[com1 x| [57600 =]

(! Modem Connection
Port Baud Initialization String

|com1 ] |57600 |

Phone Number

different one is used, select it from the drop down [ ]
menu. C Metwork Connection
Baud rate for both is 57600. Select it in the drop I%I
down menu if it is not specified.
Modem Connections require an Initialization
0K LCancel

String, which can be found in the modem

manufacturer’s user guide. A standard string that
works with most modems is at&f&c18d2.

Type in the phone number used for the Modem Connection, including area code and any
numbers needed to dial out of the installation site.

Network Connections require an IP Address or a computer name if utilizing DHCP, see
your IT person.

5. Click OK or press Enter.

The Remote Location has been defined.

Connecting to and Disconnecting from the Remote Location

The MediaCreator and the MediaXtreme display unit must be connected for pages,
folders and the schedul e to be sent to the display unit.

The connection establishes the data link between the MediaCreator and the MediaXtreme
through whichever interface has been used--serial cable, modem or network.

Off-LineVsOn-Line

When there is an active connection, the system is considered “on-line.” When thereis no
active connection, the system is considered “ off-line.” MediaXtreme continues
displaying pages based on its current schedule whether it is off-line or on-line.

That means that all page, folder and schedule creation and editing can be done off-line
while MediaXtreme continues to run its current schedule. When the new information is
ready to be sent, connection is established and the schedule is updated. Changes take
place immediately upon receipt of the update. Once the update is complete, the system
can be disconnected again.
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It is possible to be on-line during page, folder and schedule creation and editing but it
isn’t necessary.

To connect to the Remote L ocation:
1. Select the Communications menu from the menu bar. Communications

Mew Remate Location
. . . Edit R be Locati
The Communications drop down window appears. T
isconmest
FEL Y Eraion
2. Select Connect. 2end ’
EEtieye F
Emergency 3
The Connect window appears with the defined Remote L ocation Hise ’
name already selected. If there were multiple Remote L ocations, Lego Lorfiguation
. . R e ate S nehTEmEs
the drop down menu would allow selection of any location defined. B e
Connect 1 Pazzword
"Remote Connection™ ] ol i i o i
Pleaze enter your password
Pazzword
e |
Type: Serial
Port: 1 Confirm Password
B aud: hyb00
MHumber:
IP Address:
Connect 1 LCancel Login Cancel
All parameters for the location appear on the window.
3. Click on Connect or press Enter.
The Password window appears.
4. Typethe password MDX in the Password and Confirm Password fields (tab between
them) and then click Login or press Enter.
A confirmation window appears to verify a successful Text Editor =
connection. Successfully lngged into remote spstem

5. Click OK or press Enter to remove the confirmation and
connection windows.
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To disconnect from the Remote L ocation:
1. Select the Communications menu from the menu bar.

The Communications drop down window appears.
2. Select Disconnect.

Text Editor
Disconnection happens immedi ately Succezzfully logged out from remote zite

A confirmation window appears to verify a successful
disconnection.

3. Click OK or press Enter to remove the confirmation
window.

Synchronizing Time and Date

The time and date settings on the MediaCreator and the MediaXtreme must be the same.
aswell as correct for scheduled events to properly function. Scheduled events based on
time of day and date will be created and sent to the MediaXtreme to berun. If thetime
and date setting is wrong on the MediaXtreme, the events will not run when they are
supposed to.

Thelogicissimple. Make sure the time and date settings on the MediaCreator computer
are correct. Use the Internet and synchronize to the Atomic Clock or an Internet Time
Service for maximum accuracy. Then run the Time/Date Synchronize function in the

M ediaCreator—this synchronizes the MediaXtreme to those settings.

The units must be connected for synchronization to work. We recommend synchronizing
clocks each time you connect MediaCreator to MediaXtreme. MediaXtreme will hold
the settings until another synchronization is performed. If your applicationisatime
sensitive one, synchronize often, and verify your computer’ s time and date often.

LCommu

To run a Time/Date Synchronize:

1. Select the Communications menu from the menu bar.
The Communications drop down window appears. Eimn;{._act
2. Select Time/Date synchronize. Eil‘fe's'”” v
Retrieve 3
The synchronization happens immediately. e :
A confirmation window appears to verify a successful s

synchronization.
Text Editor

3. Click OK or press Enter to remove the confirmation

window. Successfully zet time and date on the remote unit
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Alright.... let’'s get down to business...why you're here!

The easiest way to learn MediaCreator isto useit. In this manual we will create some
pages as atutorial. In-depth factory training is available—contact your sales
representative.

Chapter 4 Schedules, Folders, and Pages

Folder Settings

Folders are a convenient way of keeping groups of pages and project settings separate
from each other. Whenever you are working in this folder, the pages will be read from
and written to this folder as the default.

Xtreme Pages Manager

The Xtreme Pages Manager is used to give you quick accessto all the pagesin your
system. Thiswindow (shown below) is on the left hand side of the screen.

All of the pages in the current project are displayed in thiswindow. The pages are
represented both by thumbnails and names of the pages. With the thumbnail, you can
tell at a glance what the page looks like. Y ou can open any page in the project just by
clicking on it in the Xtreme Pages Manager window. If there are many pages in your
system, you can scroll through the list of pages using the Page Manager scroll bar.
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Pages

When pages are saved on the disk, they are each saved in a separate file. The sizes of
these files are determined by the amount of text and the complexity of the page. Most
pages are can be 1 or 2 Kbytes unless they contain logos, textures or complex graphics.
Storage space is completely dependent upon free disk space in your system. Each page
file must be given a unique name.

The pages are stored in aformat that allows them to be fully edited, even after they are
saved. You don't need to worry about things getting “locked down” after the page has
been saved. All information needed to display the page is stored in the page file except
for the Typefaces and the background graphic. When a page has aLogo or multiple
Logoson it, thelogo is stored in the page file. Thisis done to speed up the Page Recall
time. The page file does keep track of which background graphic and typefaces are used
in the page. When apage isrecalled, the system will automatically load the needed
typefaces and the background image. When a page is saved or recalled, the dialog box
first displays with the default page directory. Y ou can select another directory to save the
page to or recall it from. The default page directory can be changed. See the section
“Default Directories” in Chapter 10 for more information on how to do this.

Creating a New Page

To create anew page, use one of the following commands:
Pressthe “New Page” button on the Toolbar.

Select the “New Page” entry from the “File” menu.

Select the “New Crawl Page” entry from the “File” menu.
Press and hold down the <Ctrl> key while pressing the <N> key.

When thisis done the process of creating a new page will begin. If the“ Automatically
Save Pages’ setting in the “User Preferences’ dialog box requiresit, the following
message box will appear.

Automatically S5ave Pages l

Do pouwant bo save
‘the changes to the
Cument page?

IF.you don't want the spstemto keep
-asking your this question; use the
"User Preferences" comiand in the
"Setup! menu to change the:
“Eutomatically Save Pages" setfings:

The system can only have one page opened at atime. When you open a new page, the
old page (or any changes madeto it) will be discarded unlessit is saved to the disk. If
you want to save the changes to the old, page press <Yes>, otherwise press <No> and

the changes will be discarded.
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If the page was not saved, the following warning will appear:

Mew Page !

\i} Thizill erase the curent page:

Are pou sure youwant ta dothis?

If you do not want to lose the changes to the current page, press the “No” button to
cancel the New Page operation. Y ou can then save the old page.

Opening an Existing Page

Opening a new page will overwrite the currently open page. Make sure that you save any
changes to the current page before opening a new one.

To open an existing page, use one of the following commands:

Select it from the listed pages in the Xtreme Pages Manager window.
Select the “Open Page” entry from the “File” menu.

Pressthe “Open Page” button in the Toolbar.

Press and hold down the <Ctrl> key while pressing the <O> key.

If the “Automatically Save Pages” setting inthe “User Preferences” dialog box is
set, the following message box will appear.

Automaticallp Save Pages E |

Do you want to zave
the changes to the
current page?

‘Mo |

If you don't want the system to keep
azking you thiz question, uze the
"User Preferences" command in the
"Setup” menu to change the
“Automatically Save Pages" zethings:

Y ou can only have one page opened at atime. When you open anew page, the old page
(or any changes made to it) will be discarded unlessit is saved to the disk. If you want to
save the changes to the old page press “ Yes”, otherwise press “No” and the changes will
be discarded.
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Once this is done the Open Page dialog box (shown below) will appear.

Open Page

Lookin: |3 Pagss =l i Fjil [: EE

1 Marianne @ Arch:pag @ Big co.pan E] charnz.pac

:.} weboard [i] Biw_poopag E] broadwan. Pal E] Clouds. pat
E] Atadd. pag ;E] bad rall.pag ;E] Co.pag ;E] Cooper.pa
;3] Airtest.pag E] Eballpag E] Cg_logo.pag E] Crazy.pag
=] Alaska pag %] Bears. pag ] Cg_logal pag %] Crwiderno.
iE] Blladin,pag !E] Big.pag !E] Cg_tle.pag !E] Cute.pag
4] | ]
File name:: I Open

Files of tipet | Pages [+ PAG) =l Bancal

Open Page dialog box
Use this dialog box to select which page to open. Once apage is opened it will appear in
the Creator window. Y ou can now edit the page.

Saving a Page

When you are finished editing a page, you need to saveit to the disk. Select the“SAVE”
or “Save Page As” entry from the “File” menu. If the page does not yet have a name,
the Save Page As dialog box will appear (see Saving a Page with a New Name) so that
you can name the page.

Often, while editing a page, you should save it to protect your work from things like
power failures. This function can be accomplished by holding down the <Ctrl> key and
pressing <S>.

All pages, folders, sounds, and schedules names must be of 8-characters or less, and
contain no spaces or symbols—Ietters and numbers only. Failure to follow this naming
convention will cause your pages, folders, sounds, or schedules to not operate as you
desire.
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Savein: | i Pages

crawl.PaG
A& rippon.Pag

weather, PG

nowplay, Pais

riowplay2 P

Ais

PROMO PAG
] promog, PAG

File name::

|FROMO1

Saye |

Save az type: |><treme Pages [ PAG]

e

Save Page As dialog box

Creating a New Folder

To create anew folder, select the “New Folder” command from the “File” or “Project
Manager” menu’'s. When thisis done awindow (like the one shown below) is

displayed.

Enter the name of the new folder (8-characters or less—no symbols or spaces) in the

Existing Folders

DEMO
MNEWSSIM
PROMO
PROMOC
SPORTS

“Folder Type

@ Page () Crawl

oK

Cancel

blank text box, select PAGE or CRAWL depending upon what you are creating, and click

OK.
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The following window will appear:

Folder Sequenc

_ Available Pages
ABC2 Tl
ABC3

ABCE

CNNHL10
CNNHL2
CNNHL3

CNNHL4 i

l:"age-lh'furmatinn

ABCA =

ABCS M
CNNHL . |
CHNHL1 <<Remove

ﬁj
MANUAL
[_Name [ Sound [ Type [ Dwell |

Add Sound I Hemove Sﬁunt‘

Date Range  Always

Days Al
Dwell 5
Transition Wipe
Craw] Speed N
Crawl Times NA

This page is where you will set which pages are included in your folder (if any at this
time) and the sequence in which they will run. At thistime, you can also add a sound to
accompany the particular page, and will be able to review the page attributes at the

bottom right corner of the window. After setting which pages and which order for the
run, click OK.

Open an Existing Folder

To open afolder, select the“Open Folder” command from the “File” menu.
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This pageisidentical to the new folder page selection window shown on previous pages.
Here you can see the pages in afolder, the sequence they will run, and you can manage
the folder contents aswell. When you are complete with the folder contents, click OK.
Folders are very important—pages are scheduled only by inclusion into folders.

Playing Back Sound with Pages in a Folder

Sound, in the form of .wav files, can be played back when displaying a page or a sequence of
pages. This adds an extra dimension to the display sequence.

Sound files are imported into MediaXtreme as .wav files that can be from any input source to the
MediaCreator, or they can be played directly in the MediaXtreme with input from external
playback devices.

Sounds are assigned to pages in the Folder Sequence window that is used to build the contents
of a folder. A sound can be assigned to a single page or to play through a sequence of pages.
The sound must be long enough to cover the dwell time of the entire sequence.

Using the Line-In on the MediaXtreme and inputting sound from a CD player, or Radio, or any
other source will constantly play over your entire schedule. Any schedule audio files will override
the Line-in feature.

The sound chosen must be at least three seconds long for each page it is assigned to play over.
For multiple pages, multiply three times however many pages it will play over.

Addlng Sound tO a Slngle Page Folder Sequence [ <]
Available Pages GOOD
BASIC ame oun: e we
To Add Sound to a Page: cooi iz R A—
IESLIDE
FIRST b
SPELLCHK
1. Open thefolder that holds the <Remove|
page the sound will be played
with.
Add Sound | Hemove Sounc‘
The Folder Sequence window for | page information |
that folder appears. Do oA Insert Sound Clip
Dwell 5 Lo 5 .
2. Cl ICk On the &)und COI umn next E'amlilsion ) :':;pe Pleaze Highlight the si:l::::ll clip you would like to
R rawl Spee -
to the page that will get the Crawl Times  NA =
sound, o .

The page’ s column is highlighted. The page named
FIRST has been selected in the window on the right.

3. Click Add Sound.

~Sound Clip Settings
Name - BIGBANG

Length: 5 E3

The Insert Sound Clip window comes up with alist of

the sounds available. ok | [_Cancel | Becord New>)|
Play | Stop | Import >3 |

If the sounds desired are not there or there are no sounds
in the system at all, they must be imported viathe I mport button.
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The Sound Clip Settings define the Name: and L ength: in seconds of the sound
highlighted in the list.

To preview the highlighted sound, click on Play. Click Stop to stop playback.

The Record New choice allows sounds to be recorded by the system if the correct
connections are available.

4. Click on OK or press Enter.

The Folder Sequence window comes up again [ ENEEEEEEE - |

and thistime it has sound specificationsin its GOOD
list. Hame Sound T‘ype Dwell
The selected sound i listed in the Sound TN P R e

column. The Type column has amusical note
in it indicating a single page sound event has
been programmed. The sound’s dwell is
specified in the Dwell column. The sound's
dwell time will override the page's dwell if
there is a conflict between them (such as page
dwell being too short).

i Sound|
To remove the sound from the page, highlight Ll

the page and click on Remove Sound. The
sound information is deleted from the list.

5. Click on OK or press Enter on the Folder Sequence window to complete the process.
6. Resend the schedule to the MediaXtreme.

All changes to the schedule involving sound require the entire schedule to be resent.
Adding Sound to Multiple Pages

To Add Sound To Multiple Pages:

1. On the Folder Sequence page, highlight the
multiple pages in the list that will get the sound.

To highlight multiple pages, click and hold the
mouse on the first page and drag it over the

e

others desired. They must be in sequence. we| [TEXT2
Or hold down Shift and click on each page
desired.
Add Sound | Remove Sound|
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2. Click on Ad d Sound. Please Highlight the sounid chn s winilid ke b O L . . .4

The Insert Sound Clip window

Dwell Times

Please chooze a dwell ime for each page shown

NOISE

comes up. NOISE2 =

3. Highlight the sound desired and click MADNESS, 3

OK or press Enter.

The Dwell Times window comes
up to allow the total dwell time of o
the sound clip to be distributed __ i . L
among the pages it will play over. B ;
In the window shown, the clip is R
nine seconds long and must S
therefore be split with three 9 9 ;
seconds over each page, which B
is the minimum it can play over a S
page. If the sound clip were R s
longer, any of the pages could be : T
assigned a longer sound playout. = e —— Eeae —

4. Click on OK or press Enter.
Igr?]'e:sll;j:ékseguence WlndOW Folder Sequence B

up. !
It now has musical notes over all
three pages that get the sound FaRD STARE __|DRUMS 3
played W|th them EaCh haS the MADNESS Add>> | MADMESS? DEUMS Iﬂi 2
name of the sound next to it and BALES N
the Dwell time of three seconds nLES? <<Remove| [TEXT2
specified for the sound. TEvE
TEXT1
5. Click OK or press Enter on the Folder i 2p:
Sequence page to end the process. SQnd.] Bemove Sound
6 " Page Information

Re-send the schedul e to the Display
Station.

CREATING CRAWLS

Crawls are created as separate crawl pages but are edited and saved just as regular pages.
Crawls have text, font and formatting attributes of their own, in addition to crawl
attributes that define their speed and how many times they will run. Thereis one crawl
position at the bottom of the screen and it can’t be changed. Aswith any pagein the
system, a crawl page must be placed in afolder to be included in the schedule. They are
placed in folders that are defined specifically as Crawl Folders. When Crawl Folders are
placed in the schedule, they are defined as Crawl Events.
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Crawl Eventsrun as separate events in the schedule and appear over al currently playing
pages.

To Create a Crawl:

1. Select the File menu from the menu bar.
|A[-@ Edt Format Toolz Communication:  Help

The File drop down menu appears. Fage Cul+B
Open b J ChlC
Save ... Clil+5 Eolder Chl+D

2. Select New from the drop down menu and L T
Crawl from the popup side menu.

Load Background. ..
RBemowe Background

Maintenance r

E xit

Fedraw
Page

Additional
Hireme
Features
Test ] LColors I Foztioning ] Row Spacing ] Logos ] Backamund- Color Bases |
Backmaund - fmags | Wariables ] Siden Window ] ‘ideo Window Edge Color Page attibites
R - [rate W alidity - = Draps of the Week =
Trarsitiore [ 1220l =] & s = e
— — | e |
: : ) - = (TR0 - i ¥ 0oz - i
Times o Crawk|1 Crawl Speed: |1 | b | &
. i
I Display Crawl Fasition Indicators i: i _'.! l i _l ] i _l [t
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3. Type the crawl message. Note that your crawl text will not wrap down the screen. It will be
one continual line, just as the crawl will appear on your final output.

4. Format the text with the same functions used in standard page creation.
5. Assign crawl attributes with the same attributes keystrokes used for any page

The Crawl Attributes window opens.

Assign aCrawl Speed from 1 to 5, where 5 isthe fastest. Speeds 2, 3and 4 are
the best choices.

Assign Times To Crawl, which tells the system how many times to repeat the
crawl when it isrun (this only appliesif multiple crawls are in the current

schedule).
Text i Colare I Fozitioning I Row Spacing I Logos i Backaround - Color Boxes I
Background - Image ] Wariables ! Video Windaw ! Video windaw Edge Calor Fage Attributes
[ — Dl ate Y alidiby - i Dlays of the \week:
Transiiari T2 ¥ EIANSE PV
5 — Stal Date - -
Times: ko Erawl:i'l Er.’a'wISpeed;!‘l '*i I —‘ I' —i j = —i
f End Date: ————
I Display Crawl Positian Indicators [EczRa i F3iRE | otk

6. Attributes are saved with the crawl page, just as with any other page.

Crawl Size Limits
The crawl sizeislimited. If your crawl istoo tall, you will see aflashing red/yellow
indicator on your creator screen, and you will not be able to save the crawl.
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By examining the flashing lines, you'll get an idea of where your text istoo large.
Reduce the text size until it fits below or above any flashing indicator. Once the flashing
warning indicators extinguish, your crawl is of acceptable size, and may be saved as any
other page.

All crawls, pages, folders and schedules must be saved with names of 8 characters or less.
L etters and Numbers only—no symbols or spaces.

Create New Page

Create anew page by selecting the “New Page” command from the “File” menu. This
could also be done by pressing the first button on the Toolbar. If you have modified text
on the current page (and “ Always Ask First” is selected under “Automatically Save
Pages’ in the “User Preferences’), awindow like the one below will appear.

Automatically S5ave Pages l

Do pouwant bo save
‘the changes to the
Cument page?

IF.you don't want the spstemto keep
-asking your this question; use the
"User Preferences" comiand in the
"Setup! menu to change the:
“Eutomatically Save Pages" setfings:

This reminds you to save any changes to the page before you create the new page. Once
you have selected “Yes” or “No0”, awarning message (shown below) will appear warning
you that the current page is about to be erased.

Hew Page !

\?) Thizwill eraze the cument page:

Bire ol sure patwant b da this?

If you pressthe “No” button the “New Page” command will be canceled. If you pressthe
“Yes’ button the page will be erased. Thiswill create a new page that is blank.

Creator Window

The Creator window is where you compose your pages. Thiswindow displays the text
graphics, background image, and effects that you are working on as you compose them.
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Typing Text

To enter text in thiswindow, point the mouse to where you want the text to appear, and
press the left button. A rectangle appears where you clicked the mouse. Thisisthe text
cursor. It showswhere text will be entered. Now type any test message; the text will
appear on your computer screen as you typeit.

If the text istoo big to fit on the screen, simply size it down with either the cursor handles
or the font size text box found on the tabs section of the program.

Moving the Cursor

Y ou can use the cursor movement keys to move the cursor around in this window, or you
can use the mouse to point to where you want the cursor to be placed and click the left
button. The Arrow keys move the cursor one character or row in the direction of the
arrow. The <Home> key moves the cursor to the beginning of the row if it’s not already
there. If the cursor is at the beginning of the row and you press the <Home> key, it will
move to the beginning of the page. The <End> key moves the cursor to the end of the
row if it's not already there. If the cursor isaready at the end of the row, it will move to
the end of the page.

Editing Text

Move the mouse over the letter in your text, and press down the left button on the mouse.
While holding down the Left button, drag the mouse to the left or right on your test text.
Notice how the cursor expands to cover more text. Any operations done to the text, will
be done to the text that is selected. Pressthe <Del> key. The text that was selected was
deleted. To get thistext back, hold down the <Ctrl> key and press the <Z> key (you
could also press the UNDO button in the toolbar). The last operation (delete in this case)
isundone. The MediaCreator will let you UNDO as many as 1000 operations.

Move the cursor to another letter in your test text. Hold down the <Shift> key and press
the <Enter> key. This splitsthe row into two rows. A new row is created under the
current row and the character that the cursor ison, and all characters after it, are moved
down to the new row.

Press the <Enter> key to move the cursor to the beginning of the next row. Hold down
the <Shift> key and pressthe <Ins> key. Thisinsertsanew row at the cursor position.
Now type another test text line. Let’'s delete this new row. We could use the UNDO
function, but let’ s use the delete row function instead. Hold down the <Shift> key and
press the <Del> key. The cursor row is deleted and all rows underneath it move up to
takeits place.

Move the cursor to afirst letter of any word in your test text. Delete thisword by holding
down the <Ctrl> key while pressing <Del>. The entire word is deleted and all text to the
right of it moves over to fill in the space. Y ou can also type over text by running in the
Overwrite mode, and you can insert text by typing in the insert mode.
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The functions that you just learned (as well as others) can aso be invoked by using the
commandsin the “ Edit” menu. This menu also shows the keyboard short cut keys for
these commands in case you forget them.

Saving the Page

Before we go through the “Erase Text” functions, let’s save the page so we can use it
later. Select the “Save Page” command from the “File” menu, or press the Third button
(with the floppy disk icon) in the Toolbar. Since this page has not yet been named, you
will be prompted to enter a name for it. Once the name has been entered (Let’s call it
FIRST) pressthe“Save” button and the page will be saved to the current project.

Notice that a small thumbnail of the page appears in the Project Manager window along
with the name of the page.

Ensure you save the page with a name that consists of 8-characters or less, and contains
only letters and numbers (no spaces or symbols). Failureto follow this protocol will
render your page useless.

Erasing Text

The “Edit” menu has commands for erasing text. Y ou can erase text from the cursor
position to the end of the row, from the cursor position to the end of the page, or al of the
text on the page.

Move the cursor to aletter in your test text, then go to the “Erase Text” entry in the
“Edit” menu and select “to End of Row” command. Notice that all of the text from the
cursor position to the end of the row is erased.

Select the “to End of Page” command and al of the text from the cursor position to the
end of the page is erased. Select the “Entire Page” command, and all of the text on the
pageis erased.

Backspace

If you make a mistake while typing (such as typing the wrong character) just press the
<Backspace> key. Thiswill move the cursor to the previous position and erase the
character there. If the system isin Insert mode, the character will be deleted. You can
then type the correct character.

Using Tabs

The MediaCreator allows you to set up to 16 tabs per page. These tabs specify horizontal
positions on the screen. Columnar text can be aligned to the tabs. If the Tab Display is
enabled, the tab positions appear as vertical lines the entire height of the screen.

The tabs behave differently depending on the typing mode. In the Insert mode, pressing
the <Tab> key will insert atab character at the cursor position. All text to the right of the
new tab will be moved to the next tab position. Pressing the <Tab> key in the Overwrite
typing mode will move the cursor to the character at the next tab position. If notab is set
to the right of the cursor, the cursor will move to the beginning of the next row.
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The width of the Tab character is automatically adjusted so that the next character is
placed at the next tab position. If no tab is set to the right of the tab character, it is treated
the same as a space. Changing the text to the left of the tab character (by entering more
text or changing the size of the text) will not move the text that you have placed at the
next tab position unless the text becomes too big to fit in the allotted space.

Normal typing will not overwrite a Tab character (even in the Overwrite typing mode).
Any text that is entered before the tab will be inserted at the cursor position and the width
of the tab will be adjusted to keep the text at the next tab position from moving. To get
rid of a Tab character, use the <Backspace> or <Del> key.

The tab positions are stored with the page. When a page is recalled from the disk, the tab
positions that the page was created with are loaded with it.

For more information on default set tabs, setting tabs, deleting tabs, and tab display see
the section titled “ Setting Up Tabs” in chapter 8.

Row Space Allocation

Astext is entered, sized, and repositioned, rows of text may begin to overlap each other,
or may appear with too much spacing between them. To set the Row spacing back to
what it should be (based on the text on the row), press the “Reset Row Spacing” button
in the shortcuts window to reset the height of every row of the page.

Cursor Movements

The cursor movement keys allow you to move the cursor around the screen. The cursor
can also be positioned with the mouse.

Cursor Up

The <?> key moves the cursor up onerow unlessit is already on the top row of the page.
Cursor Down
The <?> key moves the cursor down one row.

Cursor Left

The <? > key moves the cursor |eft one character position. If the cursor is at the left
margin, the cursor will move to the end of the next row up (provided it’s not already on
the top row).

Cursor Right

The <? > key moves the cursor right one character position. If this moves the cursor
beyond the end of the row, the cursor will move to the beginning of the next row.
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Home

Press the <Home> key to move the cursor to the first character of the row. If the cursor
is aready on the first character of the row, pressing the <Home> key will move the
cursor to the first character position of the first row of the page.

End

Press the <End> key to move the cursor to the last character of therow. If the cursor is
already on the last character of the row, pressing the <End> key will move the cursor to
the last character of the page

Page Up
Pressing the <Page Up> key will move the cursor to the last character on the screen.

Page Down
Pressing the <Page Down> key will move the cursor to the home position screen.

Setting Cursor Position with the Mouse

The cursor can be moved with the mouse. Move the mouse pointer to the desired
position and click the left button. The cursor will move to the character being pointed to.
If characters are overlapped, continue to click the left button until the desired character is
selected.

OPENING AND WORKING WITH THE SCHEDULE

Once afolder or multiple folders are created in the system, the schedule for displaying
the folders can be opened and built. The schedule is the single element in the system that
determines what folder or folders get displayed and when.

There is only one schedule for aMediaXtreme. Changing the schedule to reflect new
display requirements will be a standard and ongoing process.

Opening and Building the Schedule with a Default Folder

Thereis always a schedule as long as a remote location has been created. It may be
empty before any folders are placed into it, but it exists. To make something of the
schedule, open it and add the folders.

J3=) Edit Format Tool: Communications  Help
MNew 3
Page i

To Access the Open Schedule Function: o R
ave B3 Folder brl+

1. Sedlect the File menu from the menu bar. Schedule Ll

Load Backaground...
Remove Background

The File drop down menu appears. Mainenance »

E it

2. Select Open from the drop down menu and Schedule from the popup
side menu.

The Open Schedule window appears. It listsall the schedules
in the system. There is one schedule per remote location—
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remember, there can be multiple remote locations that really address asingle
MediaXtreme Player.

3. Click on OK or press Enter.

The Scheduler window appears. Thisisthe window where al scheduling work is
done.

Scheduler ’
WM5A Schedule

Any Any SM.TW.ThF. Sat EMERG Emergency Event
10/9/1999 [10/8/2000  |5.5at 12:00:00 |16:59:59 WEEKEHNDS |Page Event

Add Page Event I Add Crawl E\renll Add Control Eventl Delete Event I
Edit Event I Clear All Events I D ate Yiew I

(1] I LCancel |

When the Scheduler window first comes up it will not have any folderslisted init.
The window above already has three foldersin it that will be referenced as the
discussion continues.

4. Click on Add Page Event.

W Page Event [_ D] x]

[ Available Page Folders [ Attributes

@ Specific Date Range

The Page Event window comes up. :
GOoD Start Date End Date
All thefoldersin the system arelisted | |

in the Available Page Folder s box. ®s BMKT RWKT KF XS
Select and highlight the folder to add to

Start Time End Time

(12 S 00 ==+ =S o0 =]

the schedule. O Default Page Folder
) Emergency Page Folder
The Default Page Folder selection on e

the bottom of the screen allows the
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folder to be added as the default folder for the system. The system must have a
default folder which runs at all times when an event with a specific time and date
range is not valid.

If thereisthe only onefolder that will be added to the schedule, it must be made
the default folder. If thisisthefirst folder that is being added to the schedule, it is
good practice to make it the default just to be sure the system requirement of a default
folder is satisfied. Folders added later can be scheduled for specific display times and
dates and will run instead of the default during those scheduled runs.

Which folder is default can be re-assigned by deleting the current default folder and
assigning default status to another folder.

5. Click on the Default Page Folder button to define the folder as the default.

The Specific Date Range areain the window becomes desel ected and grayed out
when the folder is defined as the default. The date range parameters are used to
specify when afolder should be displayed, but a default folder does not need that, it is
always active unless another page with atime and date range overridesiit.

6. Click on OK or press Enter on the Page Event window.

Thefolder is added to the Scheduler window list.

The name of the folder appearsin the Name column. It is defined as the Default
Event in the Comment column, as the GOOD folder is in the Scheduler window
above.

Notice that the Start Date and End Date columns are shown as“ANY” because the
folder isthe default. That meansit is always active.

Notice that the Start Time and End Time columns are blank for the same reason.
Notice also that for the same reason the Days column has all the days of the week.
7. Click OK or press Enter on the Scheduler window to compl ete the process

The window |eaves the screen and the scheduleis built.

The schedule with the folder named Good — the default folder —will run continuously
with the pages contained in the Good folder once it is sent to MediaXtreme .

A schedule does not run automatically when it is built.

For ascheduletorun, it must be sent to the M ediaXtreme
Display Unit.

Sending the Schedule to MediaXtreme
Once the schedule is built, it must be sent to MediaXtreme to be activated and run.
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The MediaCreator software and the M ediaXtreme display unit must be connected

for the scheduleto be sent.

To Send the Schedule:

1. Select the Communications menu from
the menu bar.

The Communications drop down menu
appears.

2. Select Send from the drop down and then
Schedule from the popup side menu.

The system begins sending the schedule
immediately.

Windows appear giving indications of the
progress of the send. When the send is

Communications

Hew Hemote Lozation
Edit Bemate Location
[Emfnest
Disconnect
Get Yersion
Schedule
Folder
Pages and Crawilz
File

RBetrieve
Emergency

Mg

Logo Configuratian
TimesDate Sunchronize
Bun Demo

L . A

complete, a window appears confirming a
successful send.

The schedule begins to run as soon as the send is compl ete.
3. Click OK on the send confirmation window.

When changes are made to the schedule, the updated information must be sent to the
Display Unit so the changes are implemented. Sending a complete schedule can take a
reasonably long time, depending upon your connection type and speed.

Adding Folders with Date and Time Specifications to the Schedule

The power of the MediaXtreme system is tapped by adding folders with date and time
specifications to the schedule. These folders only run as specified by the date and time
limitations defined when they are added to the schedule.

The parameters that define when afolder will run can be very specific using the date
range, time of day range and day of week selections on the folder Attributes window.
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To Add a Folder with Date and Time Specifications to the Schedule:

1. Select the File menu from the menu bar.

4@ Edt Fomat Tool: Communication:  Help

The File drop down menu appears. e I —
Pae  Clb
2. Select Open from the drop down menu and Sy : . nan
Schedule from the popup side menu. Save As. [Open Schedule |
. Schedules

lists al the schedules in the system. Bemave Backaround
Typically, thereisonly one listed under
the name of the Remote Location. If the
system has multiple Remote L ocations, Exit
there will be multiple schedules.

Maintenance

3. Click on OK or press Enter.

The Scheduler window appears.
oK LCancel
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Scheduler ’
WM5A Schedule

[Start Time

ny Any SM.TW.ThF. Sat EMERG Emergency Event
10/9/1999 [10/8/2000  |5.5at 12:00:00 |16:59:59 WEEKEHNDS |Page Event

Add Page Event I Add Crawl E\renll Add Control Eventl Delete Event I
Edit Event I Clear All Events I D ate Yiew I

(1] I LCancel |

4. Click on Add Page Event.

w. Page Event H= B

The P@e Event WI ndOW " Available Page Folders | [ Attnbutes
comes up. EMERG @® Specific Date Range

. GOOD Start Date End Date
All thefoldersin the [10 =] [ =] [1599 =] [10 ~] [¢ =] [2000 =]
system are listed in the e
Available Page Folders RKSCMOCTIWCOTOFKS
box. Start Time End Time
Select and highlight the oo O
folder to add to the C Default Page Folder
SChedU| e. ) Emergency Page Folder

5. Specify the date, day of 0K ]| Cameel

week and time
parameters for displaying the folder.

Since the Specific Date Range button comes up selected, these parameters are
aready available.

Refer to the above Page Event window programming of the WEEKENDS folder as
an example for the following Page Event operationa explanations. The WEEKENDS
folder is programmed to run weekends only from 12 noon through 5 PM for a full
year beginning October 9, 1999 through October 8, 2000.
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Start Date and End Date will have the current date as their defaults. Whatever the
date range must be is specified using the drop down menus for month, day and year.
Note how the WEEKENDS event programmed above is specified to run for one full
year from October 9, 1999 through October 8, 2000.

Days of the Week determines on which days of the week within the date range the
folder will display. Click off any day when the folder should not display.
Remember, this selection defines the days for every week within the date range. So if
Sunday is deselected, for instance, the folder will never display on any Sunday in the
date range. The WEEKENDS event programmed above will only run on weekends
because the two S boxes are checked for it to run on Saturday and Sunday .

Start Time and End Time determine the time of day range for display within each
day that the folder is active using a twenty-four hour clock. Start Timeisobvious
but End Timeis not.

If the End Time hasto be, say, 5 PM, or 17:00, asin the WEEKEND folder
above, then the specified End Time must be 16:59. The folder must be OFF by
17:00, which meansit ends at 16:59.

In fact, if 17:00 wer e specified, the system would overrideit and put in 17:00:59.
Notice that on the Scheduler window, the times include seconds but seconds are
not available on the Page Event window. So the Scheduler window assumesthe
event should run until thelast second before 17:01:00 begins, which is 17:00:59.
The event would actually run one minute longer than desired.

6. Click OK or press Enter.
7. Resend the entire schedule to the Display Station using the Send Schedule function.

Adding a Crawl Event to the Schedule

Crawl events are added to the schedule using the Scheduler window where all schedule
events are programmed.

All crawl events must have display date, time and day of the week parameters assigned to
them.

Multiple crawl events can be on the schedule as long as their scheduled display times do
not conflict. add a Crawl Event to the Schedule:
1. Sedlect the File menu from the menu

A0 Edt Fomat Toolz Communcation: Help

bar.
Mew 3
- Bago Ot
TheFEile drop down menu appears. Save .. Chrl+5 Crawl Ctrl+H
Save fg Folder Ctrl+l
2. Select Open from the drop down menu and Schedule Chil+]
Schedule from the popup side menu. Load Background...
Bemove Background
T_he Open Schedulewl ndow appears. It Maintenance N
lists all the schedulesin the system. :
Typically, thereis only one listed under Ext
Keywest Technology

www.keywesttechnology.com
800-331-2019 (USA)

AK I Cancel



MediaCreator Software Operations Manual 290ct03
Keywest Technology MediaXtreme System rev4

the name of the Remote Location. If the system has multiple Remote Locations, there
will be multiple schedules.

3. Click on OK or press Enter.

The Scheduler window appears.
Scheduler |

WHMSA Schedule

Comment
Default Event
Any Any LF.5at EMERG Emergency Event
10A1141999(10/21/1999 JF.S5at [12-00:00 [13:59:59 |MAIN Crawl Event

Add Page Event | Add Crawl Eventl Add Control Eventl {
Edit Event | Clear All Events | Date Yiew |

(1] 4 | LCancel |

The Scheduler window that comes up will not have acrawl event init. The one
above aready does to be referenced for the following discussion.

4. Click on Add Crawl Event.

The Crawl Event window [EEEED
comes up “Available Crawl Folders | [ Attributes
. CRASH Start Date End Date
All the cra\/\{I foIders inthe [0 =] [11 =] [1998 =] [10 =] [z1 =] [199s =]
system arelisted in the o
Available Crawl! Folders S KMET RWwXT KF X5
bOX Start Time End Time
Select and highlight the hzzjefooz) 1o o]
folder to add to the
schedule. |y |
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5. Specify the date, day of week and time parameters for displaying the crawl.

Since the Specific Date Range button comes up selected, these parameters are
already available.

Start Date and End Date will have the current date as their defaults. Whatever the
date range must be is specified using the drop down menus for month, day and year.
The MAIN crawl folder in the window above has been given aten-day date range of
10/11/99 to 10/21/99.

Days of the Week determines on which days of the week within the date range the
craw! will display. Click off any day when the crawl should not display.
Remember, this selection defines the days for every week within the date range. So if
Sunday is deselected, for instance, the folder will never display on any Sunday in the
date range.

Start Time and End Time determine the time of day range for display within each
day that the crawl is active using a twenty-four hour clock. Start Timeisobvious
but End Timeis not.

If the End Time hasto be, say, 2 PM, or 14:00, asin the MAIN crawl on the Crawl
Event window and Scheduler window above, then the specified End Time must be
13:59. Thefolder must be OFF by 14:00, which meansit ends at 13:59.

In fact, if 14:00 were specified, the system would override it and put in 14:00:59. Notice
that on the Scheduler window, the timesinclude seconds but seconds ar e not
available on the Crawl Event window. So the Scheduler window assumes the event
should run until the last second before 14:01:00 begins, which is 14:00:59. The crawl
event would actually run one minute longer than desired. The crawl event programmed
on the above Scheduler window will occur for two hours from 12 noon until 2 PM every
day of the week between October 11" and October 215.

6. Click OK or press Enter.

7. Resend the entire schedule to the MediaxXtreme using the Send Schedule function.

The crawl event will display as scheduled.

9.6 Adding an Emergency Event Folder to the Schedule

An emergency event folder holds pages that need to be displayed in the event of
emergency situations. There can only be one emergency event folder in the schedule.
Although the folder is a page folder that works the same way othersdo when it is
displayed, it gets defined as an Emergency Page Folder when it is created and will only
be displayed when specifically called for by the Emergency function in the
Communications menu.

To Add an Emergency Event Folder to the Schedule:
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Create the page or pages for the emergency event folder.

2. Create afolder that will be the emergency folder, naming it appropriately, and place

the pagesinto it.

3. Go through the standard
process of adding a
folder to the system as
detailed above until the
Page Event window
appears.

4. Click onthe
Emergency Page
Folder button to select
that definition for the
folder.

5. Click on OK or press
Enter.

“Available Page Folders | " Attributes
EMERG | ) Specific Date Range
‘EF%EEENDS Start Date End Date
10 {10 E] |1993 F| |10 5] |10 E]|1939 F]
Days of the Week
XS PW T Wy XE S
Start Time End Time
[ (oo e [12 200 ]
() Default Page Folder
oK ; LCancel i

The folder is added to the Scheduler window as an Emergency Event with Start Date
and End Date specified as Any, and with all the days of the week specified for

display.

Running an Emergency Event Folder

An emergency event can berun at any time. It isan unscheduled event that is triggered
to run immediately when needed and is stopped immediately when no longed required.

To Run an the Emergency Event Folder:
1. Select the Communications menu from the menu

bar.

The Communications drop down menu appears.

2. Select Emergency from the drop down and Run
Emergency Event from the popup side menu.

The emergency event runsimmediately, displaying

the pagesin the emergency folder.

A confirmation window appears to verify that

the event has run.

3. Click on OK to make the confirmation window

disappear.

The emergency folder will continue to run until
the system istold to resumetheregular schedule.
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Resuming the Regular Schedule After an Emergency Event
An emergency event can be stopped at any time to resume the regular schedule.

To Resume the Regular Schedule:
1. Select the Communications menu from the menu bar.

LCormmunications Mel=]s

The Communications drop down menu appears.

HewiHemate Loeation

ermote Losationg

2. Select Emergency from the drop down and Resume Cornab
Schedule from the popup side menu. %is:ﬁnnect

Send
Betneve

Emergency

The emergency event stops running immediately
and the regular schedule is resumed.

Misc
A confirmation window appearsto verify that the —
regular schedule is running. Text Editor

3. Click on OK to make the confirmation window Successfully restarted zchedule on remate display unit
disappear.

Adding a Leightronix Control Event to the
Schedule

The Add Control Event function creates events for the optional Leightronix controller. The
events tell the Leightronix to trigger selected functions on the devices it controls or to create
switcher events.

There are three different Leightronix controllers that can be used, the MINI-T, the PRO-8
and the PRO-16. Devices controlled by these
units include tape decks and laser discs. Edt Faormat Toolz Communication:  Help

tew 3

Programming A Leightronix Control Event Fon | THLE
1. Select the File menu from the menu bar. Save .. Cirl+5 Crawl  Chil+H

Save bz, Eolder Chrl+l
Schedule Chi+l
. Load Background... 20necu i
The File drop down menu appears. B B
2. Select Open from the drop down menu and M aintenance
Schedule from the popup side menu. —
E xit

The Open Schedule window appears. It lists
al the schedulesin the system. Typically, thereisonly onelisted
under the name of the Remote Location. If the system has
multiple Remote L ocations, there will be multiple schedules.

3. Click on OK or press Enter.

The Scheduler window appears.
OK LCancel
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Scheduler

Start Date

End Date

WMSA Schedule

Any Any S.M. T W ThF S5at EMERG Emergency Event
11141999 [11/30/1999 |5 M.T.W.Th.F.5at |16:00:00 Control Event
11141999 117301999 |5 M. T.W.Th.F.5at |16:30:30 Control Event

Add Page Event | /Add Crawl Event| Add Contiol Event |

Delete Event |

Edit Event

| = Clear All Events |

D ate Yiew |

(114

LCancel !

The Scheduler window that comes up will not have control eventsinit. The one above
already does to be referenced for the following discussion. The first control event on the
schedule plays a tape machine every day at 4 PM during the month of November 1999.
The second event rewinds the tape machine at 4:30:30 PM during the same period.
Assume for purposes of the discussion that the tape is playing a 30-minute program
segment, so rewind isinitiated thirty seconds after the show has concluded.

How these events are programmed will be detailed as part of the continuing explanation
on creating a control event.

4. Click on Add Control Event.

The Leightronix Event window

comes up.

Select the controller type being used
from the Type drop down menu

in the Control

ler area

Choices include:

MINI-T
PRO-8
PRO-16.

Keywest Technology

www.keywesttechnology.com

800-331-2019 (USA)

Leightronix Event
- Controller F Switchep ————————
Type
Input [ <+
i -
Device Humber Function Delay -
‘ No Device :_j| | 1] ;.J' ‘ No Function :_i|
| Laser Disc Comm Port
Start Stop Port Humber
[ooooo | [ooD00 2 =
" Event Time
Start Date End Date
M zf[e zf[1999 =z  [11=z][s x[1e%9 =]
Dayps of the Week
WS MMT RWNT KF X5
Time

Lancel
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To build the sample event already defined on the Schedule window |ocated above,
select MINI-T.

5. Select the device that will be controlled from the Device drop down menu in the
Controller area. If aswitcher event isbeing programmed, select No Device and go
on to the discussion about switcher events (Programming a L eightronix Switcher
Event).

Choices for the MINI-T include:

No Device (selected when switcher events will be programmed)
Tape Deck (which deck will be specified next)
All Decks (indicating all decks controlled by the system)
Laser Disc (which disc will be specified next)
All Discs (indicating all laser discs controlled by the system).
Choices for the PRO-8 and PRO-16 do not include laser discs and are limited to:
No Device (selected when switcher events will be programmed)
Tape Deck (which deck will be specified next)
All Decks (indicating al decks controlled by the system
Select Tape Deck to continue building the sample event.
6. |If Tape Deck or Laser Disc has been selected, define what device number it isin the
Number drop down menu, which is activated by those selections.

Each deck or disc is defined in the system by a number. When several devices of the
same type are controlled by the system, it isimportant that the system know which
one is going to be controlled in the event.

Choices are device numbers 1 through 8.
Select 1 as the device for the sample event being built.
7. Select the control function for the selected device in the Function drop down menu.

If atape deck device selection has been made, the function choices include:

Stop
Rewind
Pay
Record

If alaser disc device selection has been made, the function choices include:
Stop

Play Segment
Play
Still

If Play Segment is selected for alaser disc event, the Start and Stop fieldsin the
Laser Disc area are activated for a segment range to be defined. The valid ranges
are from O to 54000.
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The sample event is programmed to play the tape deck, so select Play.

8. Select the com port that the Leightronix is connected to with the Port Number drop
down menu in the Comm Port area.

Port number choicesare 1, 2, 3, and 4. This specification tells the Display Station
where to look for the Leightronix input.

Select 2, which isthe usual port, for the sample event being programmed. Typicaly,
the Creation Station is connected to port 1.

9. Program the time and date elements for the event in the Event Time area.

These parameters define the time and date range within which the event will run.

Start Date and End Date come up with the current date as their defaults. Whatever
the date range must be is specified using the drop down menus for month, day and
year.

The sample event is programmed to run throughout the month of November, so
specify Nov 1, 1999 through Nov 30, 1999 as the date range.

Days of the Week determines on which days of the week within the date range the
event will run. Click off any day when the crawl should not display. Remember,
this selection defines the days for every week within the date range. So if Sunday is
deselected, for instance, the event will never display on any Sunday in the date range.

The sample event runs every day, so leave al the days of the week checked off.

Time determines the time of day that the event should be triggered using a twenty-
four hour clock.

The sample event plays the tape machine starting at 4 PM, so specify 16:00:00.
10. Click on OK.

The control event is programmed.

Based on the programming in the sample event, the event will play a tape machine every
day at 4 PM during the month of November 1999.

The Leightronix Event window for this event with all the programming would look like
the one pictured here.

A second event would be programmed with similar elements, but with Rewind as the
Function and 16:30:30 as the Time to rewind the deck after playout is complete.

The result of this programming appears on the Schedule window as seen on that window
at the beginning of thisdiscussion. The type of event is noted as Control Event but only
the date and time parameters appear in the Schedule window. No indication of what kind
of control event is scheduled appears on the window.

To find out more information about the event, highlight the event in the Schedule list and
click on Edit Event. That brings up the Leightronix Event window for the event. Event
information can be checked and changed if desired.
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Programming a Leightronix Switcher Event

Switcher events are programmed in the Switcher area of the Leightronix Event window.

The other parameters in the Leightronix Event window must be accessed as needed to program
the switcher event in the same manner as they were for programming the device control event.
Refer to the steps in the discussion above for the specific details of these operations.

Switcher Event Programming on the Leightronix Event Window

Switcher events are programmed in the Switcher or Router area of the Leightronix Event

window.

Switcher events and device control events can be programmed to occur together, in which case
the Controller area would be programmed as appropriate for the device control event desired.
For any event, the Port Number in the Comm Port area must be correctly specified (typically 2).
This is usually set once and left alone for all future operations since it will not change.

The Event Time parameters apply to switcher events just as they do to device control events, so
Start Date, End Date, Days of the Week, and Time parameters for when a switcher event
should be triggered must be specified. If both a switcher event and a device control event are

programmed together, the Event Time specification applies to both.

The Switcher or Router Area

The three supported Leightronix controllers each have different Switcher or Router areas that
reflect their individual input/output capabilities. Switcher or router capabilities are defined by how
many inputs come into a unit and how many outputs go out.

That means for multiple inputs and outputs, decisions must be made as to which input to select
and from which output or outputs the unit sends its signal. The Switcher or Router area is used
make these specifications, so its Input and Output drop down menus offer the appropriate

choices for each unit.

The MINI-T is an 8 X 1 (8 inputs, 1 output). Since it has only one output, when it is the selected
device, this area is designated as Switcher. The Input drop down menu offers input selections
from 1 — 8 to choose from and there is no output drop down menu. An input selection of “—*

indicates no switch.

The PRO-8isan8 X 3 (8
inputs, 3 outputs). Since it has
three outputs to choose from,
when it is the selected device,
this area is designated as
Router and an Output drop
down menu appears on the
window. The Input drop down
menu offers input selections
from 1 — 8 and the Output drop
down menu offers output
selections from 1 — 3 to choose
from. Multiple outputs can be
chosen for any event. An input
selection of “—*" indicates no
switch.

The PRO-16isa 16 X 4 (16

Leightroniz Event

| Controller | Switcher

Type
Input -

TETTTE = -
Device Humber Function Delay -
| Tape Deck j| | 1 j| | Play j|

- Laser Disc - Comm P ——
Start Stop Port Humber
[oooo0 | {00000 2 7

" Event Time
Start Date End Date

[ =] [+ =f[1ss9 =]

[11 =] [30 =] [1599 =]

Days of the Week

X5 XM XT KwWKT KF XS

Time

[16 =] * [00 =] |00 =]

Ok

LCancel |

inputs, 4 outputs). Since it has three outputs to choose from, when it is the selected device, this
area is designated as Router and an Output drop down menu appears on the window. The
Input drop down menu offers input selections from 1 — 16 and the Output drop down menu offers
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output selections from 1 — 4 to choose from. Multiple outputs can be chosen for any event. An
input selection of “—*" indicates no switch.

Leightronix Event
r Controller "Router

- Type Input |7 _:_i [ Output 1

LHO: 16 ‘Ij [ Dutput 2

| Device Mumber Function Delay [ Output 3

' |Nu Device _:j| ‘iﬁ :j |Hu Function _:j| [ Output 4

The Delay drop down menu for all controller types allows a delay in seconds from 0 — 99 to be
specified for each switcher event.

Switcher Event Example
A programmed switcher event on the PRO-16 that is a switch to input 6 with a delay of
55 seconds to outputs 1, 2 and 4 would appear on the Leightronix Event window as:

Leightronix Event {

Controller -
| Type X Dutput 1

_ Input (g ‘:j
PRO-16 ‘I'i X Output 2

Device Number Function Delay [~ Output 3
' |Nu Device ‘:j| |§; Fl |Nu Funclion .I.i| .......................... :

Events for the other controllers would be programmed in a similar manner depending on
the parameters desired.

~Router

Event Time parameters would be specified as desired.
MPEG EVENT

Another control event that can be scheduled isthe MPEG Player Event. These events
would be used to control MPEG player devices such as the Keywest Technology’s MX-
3-VP, or Adtec Edje and Soloists.
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MX-ONE Schedule

Start Date End Date

Ay

Start Time | End Time Mame

Caommignt

I AT W, Detault Event
EANE/2002  |EAES2005 ST ThE.Sat (0:00:00 235353  |CHAWFOL Crawl Event
B 72003 672003 ST W ThESat  |1200:00 MPEG : Play
BA7A2003 . |6A7/2003 ST ThF.Sat  |12:00:00 MPEG : Play
Add Page Folder Event | Add Leightronix Evert | Edit Event |
Add Crawl Folder Event | Delete Event |
DateView | Clear &l Events |
5]:¢ Cancel
Click on Add MPEG Event, the MPEG event window will open.
i
S —
MPEG Function Fort Mumber
I'I Tl
—Event Time
Start Date Endt Date
{5 =l 7 =] 2003 =] {5 =l 7 =] 2003 =]
Davsof Week
MSVMWVMT VWV TWFWS
Time
[12 =) ¢ fo0 =] = oo =
ok | Cancel
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Y our MPEG player device should be connected serially to your MediaXtreme so
commands are relayed between the two devices. Ensure COM PORT is set to the proper
MediaXtreme Port Number (Thisis normally Port 1, unless you have other serial devices
such as Weather Instruments, or Leightronix devices)

Under the category MPEG Function, there are several available options:

' MPEG Control x|

— Com Palt——
MPEG Function Fort Mummber

—

£, STOP
- EYIREPEAT ONE
REPEAT ALL End Date
REFEAT LAST = = = -
ENECERT LT 1 6 =] [18 =] [2003" =]

Daysof Weak
VEWMMVTWVWVTWFIWVS

Time

[12 =] = oo =] = {00 =]
ak | Cancel

PLAY—Plays the current spot (Clip) from the MPEG player’s Play List (next in queue)
PLAY SPOT—Play a specific spot by name

STOP—Stops any spot that is playing

REPEAT ONE—Repeats the current spot until stopped

REPEAT ALL—Cyclesthrough entirelist or inventory of clips on MPEG player
REPEAT LAST—Plays entire list to the end, and repeats the last spot only

REPEAT OFF—Playslist to conclusion, then stops

Just as Leightronix control events, or page events, or crawl events, you can set your
MPEG event to be “aways on”, or select certain days, dates, and times for the event to be
active.
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Once selected, set, and OK isclicked, it will appear in the schedule list like any other
event, except it will describe that it is an MPEG event, and what type of function it is set
for in the schedule’ s comment column (as shown below)

“* scheduler |
MX-ONE Schedule
Start Date End Drate Start Time | End Time M arne Comment
Ay Ay ST MW THE S at WitED [efault Event
B/1EA2002 | BAGBAZ005 S TMCThESat (00000 235359 |CRAWFOL Crawl Event
EA7/2003  |BATA2003 S M. TW ThESat (120000 MPEG : Play

B

2003 |6A7/2003_|SM.IW.ThFSal |12.0000 MFEG. Fla
/2003 SMIWIhFSal [120000 | | MPEG Phy |

Add Page Folder Event | Add Leightronis Event Edit Event
Add Crawl Folder Event |

|
Delete Event I
| Clear All Events |

[rate Yiew

(] Cancel

Additional Scheduler Window Functions
The Scheduler window has other functions that can be accessed as needed.

Edit Event

Highlighting an event in the Scheduler window and clicking on Edit Event brings up the
Page Event or Crawl Event widow for the selected event depending on type. Changes
can then be made to the event. Click OK or press Enter to save the changes made.

Delete Event

Highlighting an event in the Scheduler window and clicking on Delete Event allows the
event to be removed from the schedule. A warning window comes up before the deletion
isalowed. Click on Y esto delete the event.

Clear All Events

Clicking on Clear All Eventsalowsall eventsin the schedule to be removed. A
warning window comes up before the clearing of all eventsisallowed. Click on Yesto
clear the events.
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Date View

Date View alowsalist all events that are scheduled
for a specified date to be seen. When Date View is el BB L e
ggl Celéﬁocla r?rt] otrt])ee [S)paé?:igggl ce window comes up for date W] [11 =] [1999 =]

When OK isclicked on, the Date View window
appears, listing all the events scheduled for that
date. Start Time End Time

VARIABLES (AKA TOKENYS)

Variables, the feature formerly known as Tokens, are the MediaXtreme's way of
displaying dynamic data on pages and in crawls. They can be used to add time, date,
temperature, wind speed, and more to your pages. They can also be used for real-time
data services. Variableswork just astheir name indicates. Placing them on the screen
will hold a spot for actual dataat “run” time...when your pages are playing live.

All systems are capable of utilizing time and date variables. Other variables are
dependent upon options you have purchased for your unit. This could include AP®
Newswire service, Weather services, Sports services, Data services and more.

Click on Variables tab.

Keywest Technology 64
www.keywesttechnology.com
800-331-2019 (USA)



MediaCreator Software Operations Manual 290ct03

Keywest Technology MediaXtreme System rev4
Teut ] Colors: ] FPozitioning ] Frow Spacing ] Logos Background - Calor Baosies: ]
Backoround - Image Varables ] Yiden Windaw ] Yideo Windaw Edge Enlar Fage Attributes ]
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e ] Ehp————— __1 R T

Now, click onthe ADD NEW VARIABLES button. Y ou will see all available variables
for selection.

Clicking on aVariable will make it appear on your page where your cursor is currently
positioned.
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Available Standard Variables included with your MediaCreator and MediaXtreme are as
follows:

12 Hour = numeric hour based on 12 Hour Clock (ex. 9)
24 Hour = numeric hour based on 24 Hour Clock (ex. 21)
Day of Month = current day of month (ex. 18)

Full Date (MM/DD/YYYY) = ex. 12/28/2002

Full Year (2003) = ex. 2003

Long 12 Hour Clock = ex. 9:12:33 PM

Long 24 Hour Clock = ex. 21:12:33

Long Day of Week (Tuesday) = ex. Tuesday

Minutes = numeric minutes based on current time (ex. 12)
Month (Aug) = Abbreviated Month (ex. Aug)

Month (August) = Month Name (ex. August)

Month Number = Month Number (ex. 8)

Seconds = numeric seconds based on current time (ex. 33)
Short 12 Hour Clock = ex. 9:12 PM

Short 24 Hour Clock = ex. 21:12

Short Day of Week (Tue) = Abbreviated name of weekday (ex. Tue)
Short Year (03) = Last two digits of current year (ex. 03)

The other standard variables listed in the tab consist of Rainwise weather instruments
variables. They are only functional if you own a WS-1000 or WS-2000 Rainwise
Weather Station. Contact your sales representative for further details.

DISPLAYING WEATHER INFORMATION - THE WEATHER
STATION OPTION

The optional Wesather Station package enables current live weather information to be
included on pages displayed by MediaXtreme

Weather Station Installation
The Weather Station should be installed before the MediaXtreme is turned on.

To Install the Weather Station:

1. Assemble the Weather Station as per documentation included with it.

2. Find the nine-pin serial cable enclosed with the unit.

3. Connect the cable end labeled PC to the appropriate serial connector on the back of
the MediaXtreme and the other end to the Weather Station serial connection.

4. Insert the power cord in the Weather Station, plug into a power source and power on

the unit.
5. Power on your MediaXtreme.
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Displaying Weather Information on a Page

Wesather information generated by the Weather Station remote unit can be displayed on
any page through the use of Variables. Typically displayed weather information includes
outside temperature, rainfall, barometer readings and wind speed. When apage is created
that will have weather information included on it, variables are placed on the pagein the
exact location where the desired information should appear. The actual weather
information will not be seen on the MediaCreator screen when creating or editing the
page. (The Preview Page function also shows just Variables.) When the page with the
Variablesisrun in the schedule and displayed by the display unit, the weather
information defined by the Variables will be on the page in place of the variable.

Spacing and additional characters are used when creating the Multiple variables can be
placed on apage asrequired. Use readability and a sense of page design as guides for a
practical limit.

Rainwise Weather Readings Include:

Inside Temperature
Outside Temperature
Max Outside Temp
Max Outside Temp Time
Min Outside Temp
Min Outside Temp Time
Inside Temp in Celsius
Outside Temp in Celsius
Max Outside Temp in Celsius
Min Outside Temp in Celsius
Barometer
Max Barometer
Max Barometer Time
Min Barometer
Min Barometer Time
Barometer in mmHg
Max Barometer in mmHg
Min Barometer in mmHg
Wind Direction
Wind Speed in mph
Max Wind Speed
Wind Speed in kph
Wind Speed max in kph
Max Wind Speed Time
Wind Chill
Min Wind Chill
Min Wind Chill Time
Rainfall
Rainfall Accumulation
Humidity
Heating Days
Cooling Days
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ADDITIONAL SYSTEM FUNCTIONS

Maintenance: Deleting Schedules, Folders, Pages and Crawls,
Backgrounds and Sound Clips

The Maintenance functions are found in the File menu. They allow various system elements to
be deleted.

Caution should be taken when deleting anything from the system. And, of course, the system will
prompt for confirmation before it will allow anything to be deleted.

x|
M Netwark 1000103
SEORTS | Metwork 10.0.0.104
[relete Done

When a selection is made, a window will appear listing all the elements of the type selected, such
as schedules or folders. Choose the element from the list that must be deleted and click Delete.

Delete Schedules [Remote Connections]

Mumber

Delete LCancel

IP Address

=|

Delete Folders
CRASH Crawl
EMERG Page
GOoOoD Page
MAIN Crawl
TUESDAY Page
WEEKENDS Page

Delete I

Cancel |

NOTE: Deleting a schedule assigned to a Remote Location not only removes all schedule
information, but removes the definition of that Remote Location from the system

as well. If that was the only Remote Location the system had, a new Remote

Location would have to be defined for any displaying of pages to be done.
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Get Version

This selection in the Communications menu brings up awindow that states the software
version of MediaXtreme that is running in the system. For example, a MediaXtreme
might return version number 10009.

Retrieve, Misc and Send File

The Retrieve and Misc selections in the Communications drop down menu and the File
function in that menu’ s Send selection are used for software maintenance by trained
technical support personnel

Run Demo

This selection in the Communications menu runs a prel oaded demo program that
illustrates the features of MediaxXtreme.

Chapter 4
Text Styles

MediaCreator gives you a surprising amount of control over the text style. Thetext is
made up of the two different components. These are the character and the edge.

Y ou can select any true-type font for the character (either already on your computer, or
imported from elsewhere). Y ou control the Height, Width, Italics, and the Color of the
character. For the edge you can select the Edge Type, Direction, Depth, Blur and the
Color.

Many of the text style attributes (height and width for example) are represented
numerically. These numerical attributes can be modified by controls that are either
absolute or relative. An absolute control will set all of the selected text to the new value.
A relative control will change all of the selected text by the same amount.

To illustrate the difference between absolute and relative, let’s assume there isaword on
the screen. The first character of the word is 50 scan lines. Therest of the word is 25
scan lines high. If you select the entire word and use arelative control to increase the
height of the first character by 25 scan linesto 75 scan lines, the height of the rest of the
word will be increased by 25 scan linesto 50 scan lines.

If you use an absolute control to set the height of the first character to 60 scan lines, the
height of the entire word will be set to 60 scan lines (they won't maintain their height
relative to each other).

Text Styles

To change the text style, select the Text Tab in the Control Tab Window. The controls
for adjusting the text style will be displayed as shown below.
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This control tab window has 4 groups of controls to control numerical text attributes.
There are controls used to select the Edge Type and direction. It also has a Cursor
Handle Button to turn the cursor handles on and off, a selection box that |ets you change
the Typeface, and a button you can press when you want to Italicize the text. It even has
a button that you can press when you want to load new Typefaces.

The numerical control groups are:

” Height

7 Width

” Edge Depth
” Edge Blur

Each group of numerical controlsis made up of 4 controls. The top control in the group
(the one with the icon) is a drag button. The drag button is the relative control of the
group. To usethe drag button, move the mouse over it, press the left mouse button, and
drag the mouse. Moving the mouse up or to the right will increase the value. Moving the
mouse down or to the left will decrease the value. The other three controls in the group
are the absolute controls.

The absolute controls consist of a number box and two small buttons to the right of it for
increasing and decreasing the value. The value in the number box can be entered directly
by moving the mouse over the number, double clicking the mouse (thiswill highlight all
of the digitsin the number), and entering the new value. The value can be increased by
pressing the increase button to the right of the value. If you hold this button down the
value will continue to increase until you release the button. To decrease the value, press
the decrease button. Holding down this button will continue to decrease the value until
you release it.

If you move the mouse over the number, then press and hold down the left mouse button,
you can change the value by moving the mouse. Moving the mouse up or to the right
will increase the value. Moving the mouse down or to the left will decrease the value.
When you have the desired value, release the left mouse button.

The Cursor Handle Button allows you to turn the cursor handles on and off.

The Typeface selection box lets you select a different Typeface. Thisis used to select
from any of the 10 typefaces that are currently |oaded.

Let’s explore these buttons allittle closer. Create a new page by pressing the New Page
icon in thetoolbar. From the style gallery select areasonably sized text style. Then type
theword “TEST” in all capital letters. Pressthe <Home> key to move the cursor to the
first “T” inthe word “TEST".
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Move the cursor over to the Height Drag Button, press and hold down the left mouse
button and move the mouse up. Notice that the size of the character increases. Release
the left mouse button.

Drag the mouse across the entire word to select it. Move the mouse over the Height Drag
Button, press and hold down the left mouse button, and move the mouse down. Notice
that the height of every character in the word decreases by the same amount. The value
of the number box is changed to display the current height of the first character that is
selected.

Now let’s see how the absolute controls behave differently. Move the mouse to the
height number box and double-click it. Thiswill highlight all of the digits. Re-enter the
digits exactly asthey were before (if they were originally 48, enter 48) and press the
<Enter> key. Noticethat all of the characters became the same size as the first
character, they did not maintain their relative character heights.

The height of the characters can be varied and set to any size between 10 and 250 scan
lineshigh. Try experimenting with the height controls to see how they affect the
characters.

Changing the width of the characters will make them appear thinner or wider. The width
can be varied anywhere between 10 percent of normal (very thin) to 500 percent of
normal (five timestheir normal width). A width of 100% is the normal width for the
character. Try experimenting with the width controls to see how they affect the
characters.

Theitalics of the text can be turned on and off. When text isitalicized, it leans to the
right. Try experimenting with the italics controls to see how they affect the characters.

Cursor handles

Cursor Handles are points on the cursor that allow you to click and drag the text around
the screen. These handles can be used to move and size the text. The Cursor Handle
Button is used to turn the Cursor Handles on and off.

Turn the cursor handles on by pressing the Cursor Handle Button. Notice that six small
boxes appear around cursor. Each of these small boxesisahandle. Y ou can move the
selected text by clicking on the handle in the lower left corner and dragging the mouse.
Each time you pause the mouse, the text will be redrawn at the new position. If you only
want to move the text horizontally (without affecting the baseline alignment) you can use
the handle on the left side of the cursor. If you accidentally move the mouse vertically
while dragging this handle, the text will not move vertically. Using the handle on the
bottom of the cursor will only move the text verticaly, it will not allow it to move
horizontally.

Use the handle at the top of the cursor to adjust the height of the characters. When you
change the size of the cursor by dragging this handle, the height of the text will be
changed to match the cursor size. The relative size of each selected character will be
maintained.

Use the handle on the right side of the cursor to adjust the width of the text. Dragging
this handle left or right will change the relative width of each character that is selected.
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When you change the width of the cursor by dragging this handle, the relative width will
be adjusted to fit within the new cursor size.

Dragging the handle on the upper right corner of the cursor will adjust both the height
and width of the text.

When you are through using the cursor handles, and you no longer want them to be
displayed, pressthe Cursor Handle Button again to turn the handles off.

Typefaces

The typeface selection box shows the current typeface. 1f you open this box up by
pressing the down arrow on the right hand side, all of the typefaces that are currently
loaded will appear. Click on any typefacein thislist to select it. When anew typefaceis
selected, the selected text will be redrawn with the new typeface.

Loading New Typefaces

MediaXtreme can load two types of typefaces, Cayman Graphics proprietary format or
TrueType format. The TrueType format isthe most popular format and has the widest
selection of typefaces. Y ou can load up to 10 typefaces for each project. When you use
typefaces on a page, the system keeps track of which typefaces are needed to display the
page. If the loaded typefaces do not match the typefaces needed by the page, the correct
typefaces are automatically loaded.

To load new typefaces press the “ Add New Typefaces” button. When thisis done the
Load New Typefaces window will appear as shown

below.
Load Hew Typefaces E
E{rac_turleg:
“falable Tupsfaces CAWINDOWSAFENTS Loaded Typefaces
Ardale Moro [PA, BN Boston Black
2l %&%NNDT%WS Biust Hand
Arial Bold crackhoue
Arial Bold Italic Futurist Regular
Arial ftalic Century
Arial Black &1 Cnpdigh
Comic Sans A = SrENCIL REGULAR
Comic Sans M5 Bold Mew York Deco
Courlier MNew Hobby Headline
Courier New Bold —— Faemed Forger
Courier New Bold | ] ; SC LI
Typetace Format —
T Cayman Graphics
Load Bemove Diore
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Load New Typefaces dialog box

The typefaces that are currently loaded are listed on the right hand side of this window.
The typefaces that are available to be loaded (in the current directory) are listed on the
left hand side. The current directory is displayed in the center.

Select the typeface format (TrueType or Cayman Graphics) that you want to load. All of
the typefaces in the current directory of the selected format will appear on the left side
under “Available Typefaces”. If thetypefaces are TrueType, the full name of the
typeface is shown in the actual typeface (for example, the name Helvetica will appear in
the Helvetica typeface, the name Times New Roman will appear in the Times New
Roman typeface). Y ou can use this feature to preview the typefaces without the need to
load them first. To get a better ook at atypeface, click onitinthislist. A larger sample
of this typeface will appear.

If the desired typeface is not in the current directory, select the proper directory. Your
system typefaces are usually stored in the “*C\WINDOWS\SYSTEM” or
“C:\WINDOWS\FONTS” directory\folder.

The typefaces do not need to be installed on your system. Y ou can load typefaces
directly from a CD-Rom or even the internet. When you load a TrueType typeface, a
copy of it is made on your hard drive. Y ou can then remove the CD-Rom and the
program will still be able to find the typefaces when it needs them.

To load anew typeface, select the position that you want to load it into in the “Loaded
Typefaces” list, select the typeface to load in that position from the “Available
Typefaces” list, then press the load button. The new typeface will appear in the
“Loaded Typefaces” list and the next position in the “Loaded Typefaces” list will be
selected. The typeface may also be loaded by double-clicking on it in the “Available
Typefaces” list.

When you have finished loading typefaces, pressthe “ Done” button and the Load New
Typefaces window will disappear. Notice that the new typefaces now appear in the
Typeface Selection Box.

Scope Selection

Now that we have the basics of character attributes down, let’ s try something alittle more
advanced. Create anew page. Set the character Height to 24 scan lines, the Width to 100
percent, turn off theitalics. Select a clean/easy to read typeface such as Boston Black,
Futurist, or Bassett Bold. Now type the following three lines of text:

The quick Brown Fox

jumped over the

lazy dogs back.

Place the cursor on the M in the word jumped and select a different typeface. Notice that
only the character under the cursor changed. If the toolbar is visible (above the title
compose window) you' || see a selection box with the words “ Selected Text”. Thisis
called the“ Scope Selection Box.” This selection box is used to determine how much
text the Text Style changes will affect. If the toolbar is not visible, display it by selecting
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the“ Display Toolbar” command from the “View” menu. Open this box by pressing
the down arrow and the following options will appear:

Selected Text

to End of Word

Entire Word

to End of Row

Entire Row

to End of Page

Entire Page

3IIIII

Change this selection to “to End of Word”, then turn the italicson. Notice that every
character from the M to the end of the word isitalicized. Go back to the toolbar and
change the selection to “Entire Word”. Increase the height to 48 scan lines. Notice that
the height of the entire word changed. Now select the “to End of Row” entry from the
scope selection box and set the width to 50 percent. Notice that all text from the cursor
position (the M in jump) to the end of the row changed its' width.

Set scope to “Entire Row” and selected a new typeface. Every character on therow is
now drawn with the new typeface. Select “to End of Page” from the scope selection
box and set the height to 60 scan lines. Every character from the cursor position to the
end of the row, and every character on every row after the cursor changed to the new
height. Now select “Entire Page” as the scope and select a new typeface. Notice that
every character on the page changed to the new typeface.

When “Selected Text” is chosen, the changes are applied to the character or group of
charactersthat are selected by the cursor. To select multiple characters, move the mouse
to the first character to select, hold down the left mouse button, and drag the mouse to the
last character to select. Dragging the mouse will not select text that is on more than one
row unless the <Shift> key is held down while the mouse is being dragged.

Row Spacing (Leading)

When we increased the size of the text, the rows of text overlapped each other.
Sometimes we want this effect, other timeswe don’'t. If you want to adjust the row
spacing to match the text, pressthe “Reset Row Spacing” button in the“ Shortcut
buttons” window (to the right of the title compose window). Thiswill adjust the row
spacing (leading) so that the rows don’t overlap.

With “Entire Page” still selected as the scope, set the Height to 24 scan lines and turn
theitalics off. Now there istoo much space between the rows. Pressthe “Reset Row
Spacing” button again and the excess row spacing (leading) will be removed.

Edge Type

The Edge Type s controlled by a group of five buttons. These buttons are called radio
buttons because only one button can be selected at the time (just like buttons on the car
radio). Pressing one button will deselect the others. These buttons are used to select the
edge type and to indicate the current edge type. The edge types that can be selected are
asfollows:

il No Edge
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Shows just the characters without any edge.

AI Full Surround Border

Displays the characters with a border around them. The border has equal depth on all
sides of the character. The depth of the border is set by the Depth controls.

_ﬁl Extruded Shadow

Extruded Shadows appear connected to the character. This gives the characters sort of a
three-dimensional look. The direction of the shadow is determined by the Direction
controls, and the depth is set by the Depth controls.

g Highlighted Shadow

A Highlighted Shadow is very similar to an extruded shadow. However afine border
appears to highlight the character. The direction of the shadow is determined by the
Direction controls, and the depth of the shadow is set by the Depth controls.

_?_‘.I Offset Shadow

An Offset Shadow is separated from the character. This makesit appear as though the
character is above the background and is casting a shadow onit. The direction of the
shadow is determined by the Direction controls, any offset of the shadow is set by the
Depth controls.

Pressing the appropriate button selects the edge type, that button then appears depressed
to indicate the current edge type.

Edge Direction

The direction of the extruded shadow, highlight shadow, and offset shadows can be
controlled. The direction is controlled by the direction control group shown below.

—Direckion

ElLEilF
Al
| |

There are eight buttons around the outside of this group. Each button represents one of
the eight possible directions (Upper Left, Up, Upper Right, Right, Lower Right, Down,
Lower Left, and Left). Pressing one of these buttons will select the corresponding
Shadow Direction. When the direction is selected, the button appears depressed to
indicate the current direction.

There is a'so an button/indicator in the middle of the Direction Selection Buttons. This
also indicates the current shadow direction. Pressing this button will advance the shadow
direction clockwise to the next direction.
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Edge Depth

The depth of the edge is a numerical parameter that can be varied from 0 to 99 pixels. An
edge depth of zero will not be seen unless you make the edge blurrier than the character.
Setting the edge depth to 99 scan lines will make an extremely deep edge that may slow
down the drawing of the characters. If you want areally deep edge like this, | suggest
that you compose the page using asmaller edge first. Thislets you compose the page
without being slowed down too much. After the text is typed, you can make the edges as
deep asyou want. The edge depth will not have any effect on the edge if the Edge Type
isNo Edge.

The numerical controlsin this group work just like the numerical controls for the Height
and Width.

Edge Blur

The amount of blur on the edges can be changed by the controlsin this numerical control
group. A Blur setting of 2 gives acrisp sharp edge, ablur setting of 12 gives you afuzzy
edge.
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Text Colors

Select the “Colors” Tab in the Control Tab Window to adjust the Text Colors. This
will display the Colors Control Window (shown below).
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The Colors Control Window has three main sections. The first section (on the left) is
used to select which component of the text (character, shadow 1, edge, and shadow 2) to
change the color of. The next section is agroup of buttons used to select the method of
choosing a color (color picker, color sliders, color palette, color gradient, or textures).
The last section has the controls used in choosing a color. These controls change based
on the method of choosing a color that you have selected.

Text Component

The component group of controls contains four buttons for selecting which component of
the text to change the color of, (character, edge, or shadows). To change the character
color, press the “Character” button. To change the color of the edge, press the “Edge”
button. And so on. When a new text component is selected, the color indicator box in
the lower left corner of this group is changed to display the current color. The color
indicator box displays the current color asit is being modified.

The component section of the Colors Control Window has an indicator to show the
current color of each text component. These boxes display the text components in the
same order that they will appear on the screen. The front box of thisindicator shows the
current Character color. The box behind it (that is offset down and to the right of it),
shows the current Shadow 1 color. The box that is behind to both the Character and
Shadow 1 indicators, displays the current Edge color. The box behind and offset down
to theright of the Edge indicator, displays the current Shadow 2 color.

If you click on any of these indicators, the component that it represents will be selected.
The appropriate component selection button will appear depressed to indicate the current
component. The color indicator box will also be changed to the color of the selected
component.
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Color selection methods

There are five different methods of selecting acolor. These methods are as follows:
?? Color Picker

The Color Picker lets you select the color using avisual approach.

rds Color Sliders

The Color Sliders lets you select the color using a numerical approach.

?? Color Palette

The Color Palette |ets you select a color from a palette of 64 preset colors.

rds Color Gradient

A color can be selected from a group of 64 user defined color gradients. This may be
either alinear gradient with up to 16 color points that can be rotated up to 90 degreesin
either direction. It can also be an area gradient that can have four or five color points
defined.

?? Color Texture

A Color Texture can be selected from any of the 4 textures that are currently loaded.
Before we begin experimenting with changing colors of the text, we should have some
text that uses the edge and both of the shadows. Let’s open the “Shadows” page (if it
isn't already open) that we created earlier. Drag mouse across the entire word to select
all of the characters. We are now ready to play with the colors.

Color Picker

Press the “Picker” button to display the color picker controls. The color picker controls
are shown below.
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The top and bottom of each character component can each be set to different colors.
There are two boxes to select whether we want to change the top color, the bottom color,
or both. If the top and bottom colors are different, the text will be drawn with a smooth
color spread between the two colors.

Below these check boxesis an lllegal Color Indicator. If the selected color exceeds
NTSC or PAL limitations, this box will appear red to indicate that you have selected an
illegal color. Otherwise thisbox will appear green.

Below theillegal color indicator isthe “Pick Color From Screen” button. Pressing this
button will change the appearance of the mouse to look like an eye dropper. Move the
mouse to position on-screen that you want to copy the color of, press the left mouse
button and the color under the mouse will be selected.
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To theright of these controlsisthe Hue Picker. Thisletsyou select the hue (red, green,
blue, etc.) of the color. Place the mouse over this control, and press the left mouse button
to select the desired hue. When the new hue is selected, the text will be redrawn with the
new color, and the Color Picker Area (to theright of the Hue Picker) will also be drawn
with the new hue.

Once the Hue is selected you can now pick the color. Place the mouse over the Color
Picker Area and press left mouse button. Thiswill select the color under the mouse. If
you hold down the left mouse button while you move the mouse, the text will be redrawn
with new color each time you select a new color by moving the mouse.

Y ou can also control the Transparency of the color. The transparency setting can make
the color fully opaque, semi-transparent, or fully transparent. When a color is semi-
transparent, the text component is drawn as tinted over whatever is behind it. When the
color isfully transparent, it can’t even be seen on the screen. Setting the transparency
level to 0 makes the object fully opaque. Setting the level to full (255) makes the object
fully transparent. Any value in between makes a color that is semi-transparent.

There are avariety of ways to change the Transparency level. Thelevel can be
increased by pressing the increase button to the right of the transparency number box. If
you hold this button down the level will continue to increase until you release the button.
To decrease this value, press the decrease button. Holding down this button will continue
to decrease the value until it isreleased. If you move the mouse over the transparency
number box, then press and hold down the left mouse button, you can change the value
by moving the mouse. Moving the mouse up or to the right will increase the value.
Moving the mouse down or to the left will decrease the value. When you have selected
the desired value, release the left mouse button.

The value of the transparency level can be entered directly. Do this by double-clicking
the transparency number box (thiswill highlight all of the digits in the number), typein
the new value and press the enter key.

The color can be also mixed with background video. Setting the video level to avalue of
zero makes the object the selected color. Setting the video level to full (255) draws the
object with background video. Any value in between makes the object appear as
background video that is tinted by the selected color. For some very interesting effects,
try blending colors, background video, and transparency over a background graphic
image.

The background video level can be adjusted in the same way as the transparency level.

Color Sliders

Pressthe “ Sliders” button to display the Color Slider controls. The Color Slider
controls are shown below.
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The top and bottom of each character component can be set to different colors. There are
two check boxes to select whether we want to change the Top Color, the Bottom Color,
or both the top and bottom colors. If the top and bottom colors are different, the text will
be drawn with a smooth Color Spread between the two colors.

Below these check boxesisthe lllegal Color Indicator. If the selected color exceeds the
NTSC or PAL limitations, this box will appear red to indicate that you have selected an
illegal color. Otherwise thisbox will appear green.

MediaCreator has two (2) numerical systemsfor defining colors. They are RGB (Red,
Green, Blue) and HLS (Hue, Luminance, Saturation). Both of these systems are used to
define the same thing (like yards and meters). Adjusting one will automatically change
the other. Y ou can select which method to use by pressing either the RGB or HLS
button. Y ou can switch back and forth between the 2 color systems at any time just by
pressing the appropriate button.

The RGB and HLS values can be adjusted by dragging the dliders, or by double-clicking
the number box and entering the new value with the keyboard.

Color Palette

Pressthe “Palette” button to display the preset color palette. The Color Palette is
shown below.
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The preset Color Palette can hold 64 preset colors. These preset colors are displayed in
thiswindow. Not al of the preset colors can be displayed at one time, so thereisa scroll
bar on the right hand side of the color palette entries. Use this scroll bar to scroll through
al of the preset colors.

The top and bottom of each character component can be set to different colors. There are
two check boxes to select whether we want to change the Top Color, the Bottom Color,
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or both the top and bottom colors. If the top and bottom colors are different, the text will
be drawn with a smooth Color Spread between the two colors.

Below these two check boxesisthe lllegal Color indicator. If the selected color exceeds
the NTSC or PAL limitations, this box will appear red to indicate that you have selected
anillegal color. Otherwise thisbox will appear green.

To select acolor from the preset color palette, position the mouse over the desired color
and click the left mouse button. Y ou can change a color in the preset Color Palette by
double clicking the entry that you want to change. For more information about
modifying the preset Color Palette, see this section “Modifying the Color Palette” in
chapter 10.

Thiswindow also has a button labeled “Background Video”. Pressing this button will
set the color so that the text will be drawn with background video.

Color Gradients

Pressthe “Gradient” button to display the color gradients. The Color Gradients
selection window is shown below.
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64 color gradients can be loaded into the system at one time. The Color Gradients that
are currently set are displayed in thiswindow. Not all of the color gradients can be
displayed at one time, so there isa scroll bar on the right hand side of the Color Gradient
entries. Usethis scroll bar to scroll through all of the color gradients that are currently set
for the project.

To select acolor gradient, position the mouse over the desired gradient and click the left
mouse button. The text will then be drawn with the selected color gradient. Y ou can edit
a Color Gradient, or build a new one, with the gradient builder. To do this, double-click
the Color Gradient that you want to modify. For more information about using the
gradient builder, see the section “Building Color Gradients” in chapter 10.

Color Textures

Pressthe “Textures” button to display the Color Textures selection window. The Color
Textures selection window is shown below.
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four (4) full Color Textures can be loaded into the system at onetime. The Color
Texturesthat are currently loaded are displayed in thiswindow. The Textures are
displayed large enough so that you can easily see what the texture looks like. Not al 4
textures can be displayed in thiswindow at one time, so thereisascroll bar on the right
hand side of the textures. Use this scroll bar to scroll through all of the textures that are
currently loaded.

To select a Color Texture, position the mouse over the desired texture and click the left
mouse button. The text will then be drawn with the selected texture. Y ou can load a new
texture by a double-clicking on the one that you want to replace. When thisis done you
will be asked to specify which graphic image you want to load as atexture. For more
information about |oading graphic images as Color Textures, see the section “Loading
Textures” in chapter 10.

Grabbing and Applying Attributes

When you enter new text it is entered with the Current Text Attributes. The text
attributes specify how the characters and edges will appear. The Current Text Attributes
are the attributes displayed in the Text and Colors control tab windows. These include
the following:

Typeface

Character Size

Italics.

Edge Blur

Edge Style (type, depth, direction)

Colors (character and edge)

3IIIIS

When you overwrite text, the text keeps the attributes of the text that you are overwriting.
If you would like to apply the Current Text Attributes to text that is already on the page,
use the “Apply Text Attributes” command. Select the text that you want to change the
attributes of, and press the “ Apply Text Attributes” button in the Shortcut Buttons
window.

If you want to grab the text attributes from text that is on the page, pressthe “Grab Text
Attributes” button in the Shortcut Buttons window. Thiswill make the text attributes
of the character under the cursor, the Current Text Attributes. The new character
attributes will then be displayed in the Text and Colors control tab windows.
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Text Style Gallery

The“Text Style Gallery” window is used to hold preset text styles. Thisisthe window
on the right side of your screen with all of the different type of “A’s’ init. The Text
Style Gallery isdesigned to give you quick accessto text styles that you will use
frequently throughout the project. Y ou can save 64 different preset text stylesin the Text
Style Gallery. However, you are not limited to just these 64 styles.

Before we begin, create a new page by pressing the “New Page” button on the toolbar.
The program will warn you that you are about to erase the current page. Since we don’t
have a page that is really worth saving, pressthe “Yes” button. Y ou now have anew
blank page to work with.

To enter text using one of the preset styles, select the desired text style (by clicking on it)
and start typing. Any text that is entered will appear with the selected text style. To
select adifferent preset text style, click on it and start typing again.

Select atext style that looks interesting and type “ This is my first preset style”. Select
another preset style and type “ This is another one”.

To change the style of text that is already on the screen, select the text, then click on the
style that you want to set it to. Move the cursor to the first character and select another
style from the style gallery. Now, move the cursor to the next character and select
another style. Continue to do thisfor every character of the first two words of the page.
Select the word “first” by moving the mouse to the “f”, press the left mouse button, and
drag the mouse over to the “t” until the entire word is selected. Then select another text
style. Notice that the entire word is changed.

Select the Character tab in the Control Tabs Window and adjust the Height of the word
“first”. Even though the character style was set using a preset style, you can still modify
the style of thetext. So, if you have atext style that is almost what you want, go ahead
and select it, then modify the attributes of the text you just changed the style of, doing
thiswill not affect the preset style in the style gallery.

Y ou can change the preset text styles. Create a character on the page that has the style
that you want to use as a preset, place the cursor on it, and move the mouse pointer to the
entry in the Text Style Gallery that you want to set to this style, and press the right
mouse button. A pop-up menu will appear. Select the “ Set Style” command. The text
style of the cursor character will be copied to the style gallery.

There are too many preset text stylesto be shown at one time in the text style gallery.

Y ou can use the scroll bar to scroll through the preset text styles. | liketo group styles
that are used together, near each other in the Text Style Gallery.

Save this page to the disk by pressing the “ Save Page” button on the toolbar. Give the
page the name “STYLES” and press the “Save” button. Y ou should seeits thumbnail in
the Xtreme Pages Manger window.
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Chapter 5
Moving Text

Once the text has been entered, it can be moved around and positioned. This can be done
either automatically or manually. Automatic positioning of pages consists of word
wrapping, word unwrapping, centering the text between the margins, justifying the text to
the margins, or removing excess row spacing from between the rows.

Manual positioning of the text allows you to move the text to nearly any position on the
screen.

To do automatic text positioning, use the “Positioning Controls” (shown below). You
can display these controls by selecting the “Positioning” tab in the Control Tab Window.
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Word wrapping and Unwrapping

Let’s start with afresh page by pressing the “New Page” button on the toolbar. A
warning may appear telling you that the current page is going to be erased. If this
happens pressthe “Yes” button. Y ou now have a new page to work with.

Set the character height to 48 scan lines, and the character width to 100%. Now enter the
following text without pressing the <Enter> key “This is going to make my job so
much easier”. Notice that when you got to the right side of the screen, the cursor
automatically went to the beginning of the next row.

Some of the words extend beyond the right margins. There are two common methods of
fixing this. The first method isto make the text smaller so that it will fit. The other
method is to wrap the words that extend beyond the margin to the next row. Since this
section deals with word wrapping and unwrapping, let’ s try wrapping the words.
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The “Word Wrap/Unwrap” section of the “Positioning Controls Window” has four
buttons. These buttons are as follows:

E Wrap One Word

E Wrap All Words

E Unwrap One Word

E Unwrap All Words

Word Wrap checks to seeif the last word of the row extends beyond the right margin. If
it does, the word is moved to the beginning of the next row. Word Unwrap checks to see
if the first word of the next row will fit on the current row. If it will, the word gets
moved up to the row above.

Move the cursor to the home position by pressing the <Home> key twice. Pressthe
“Wrap One Word” button (in the positioning controls window). If the last word of the
cursor row extends beyond the right margin, it gets moved to the next row.

If there is aword that needs to be wrapped, one word gets wrapped to the next row each
time you press this button. If there is not aword that needs to the wrapped, pressing this
button will move the cursor to the beginning of the next row. Pressthe“Wrap One
Word” button until all words that need it are wrapped to the next row and the cursor
moves to the next row. Y ou could continue to wrap the entire page this way, but thereis
an easier way to do it. Pressthe “Wrap All Words” button. All of the words on the page
that need to be word wrapped are moved to the next row.

Select al of the text on the page by selecting “Entire Page” in the scope selection box
on the toolbar. Decrease the height of the text to 32 scan lines using any method that you
prefer. Therows got narrower so that you can now fit more text on them.

Move the cursor back to the home position by pressing the <Home> key twice. Pressthe
“Unwrap One Word” button. The first word of the next row should move up to the end
of the cursor row if there’sroom for it. Pressthe “Unwrap All Words” button. Every
word on the page will unwrap to fill in the excess space at the end of each row.

Row spacing (Leading)

Notice that when you decreased the height of the characters that the height of the rows
did not automatically get smaller. The rows now seem to be spaced too far apart. To set
the row to the height that they should be, press the “Reset Row Spacing” button in the
shortcut buttons window. The height of each row will automatically adjust to what it
should be for the height of the tallest character on the row.

Y ou can have more control over the rows spacing (leading) with the “Row Spacing”
controls. Display these controls (shown below) by selecting the “Row Spacing” tabin
the control tab window.
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These controls are used to increase/decrease the spacing between the rows. The row
spacing can be increased by pressing the “More” buttons. The row spacing can be
decreased by pressing the “Less” buttons. To set the row spacing back to what it should
be (based on the text on the row) press the “ Set Default Row Spacing” button.
The buttonsin the “Change Row Spacing of” section of thiswindow are used to select
which row(s) we are going to change the row spacing of.
7? Cursor Row

Changes the row spacing of the row that the cursor is on.

7 Entire Page
Changes the row spacing of every row on the page.

Fine Positioning Text

Individual characters, words, rows, and the entire page can be fine positioned in single
pixel/scan line increments. Characters can be moved to any position on the row and can
be made to completely overlap each other. Smaller characters can be positioned inside of
larger characters. Rows can even be positioned to allow text to overlap the text of other
rows.

There are three ways to fine position text around screen. One method is to use the cursor
handles. Another method isto drag the text by moving the mouse while holding down
the right mouse button. The final method is to use the fine positioning buttonsin the
positioning control tab window.

To use the cursor handles, select the Text tab in the control tab window and turn the
cursor handles on by pressing the “ Cursor Handles” button. Little rectangles will
appear around the cursor. These are the cursor handles. The handle in the lower |eft
hand corner will move the text both horizontally and vertically. The handle on the left
side of the mouse will move the text horizontally only. Any accidental vertical
movement of the mouse will not move the text vertically. The handle on the bottom of
the cursor will only move the text vertically. Accidental horizontal movement of the
mouse will not move the text horizontally.

To move text with these handles, select the text to move by dragging the mouse over the
desired text. Position the mouse over the handle that you want to use and the cursor will
change to arrows that show which direction the text can be moved. Press and hold down
the left button of the mouse, then move the mouse. The text will follow the mouse until
you release the left mouse button.

Once you are through moving the text, you can turn off the cursor handles by pressing the
“Cursor Handles” button again.
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Y ou can quickly move the text (both horizontal and vertical) without turning on the
cursor handles. To do this select the text that you want to move and press and hold down
the right hand button of the mouse. As you move the mouse, the text will follow it until
you release the right mouse button.

To use the fine positioning buttons to move the text, display the Fine Positioning
Buttons by pressing the “Positioning” tab in the control tab window. Thiswill display
the Positioning Controls Window as shown below.
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Use these buttons to do fine incremental positioning of text. The single arrow buttons
will move the selected text one pixel each time you pressit. The double arrow buttons
move the selected text in bigger steps.

The “Reset Text Position” button will restore the text to its original (before it was moved)
position.

Centering and Justifying Text
The Positioning Tab Window has 8 types of centering and justifying controls. These are:

Left Justify
Notice how al of the lines are lined up with the left margin.

Right Justify
Notice how all of the lines are lined up with the right margin.

Horizontal Centering
Notice how al of the lines are centered between the left and right margins.

Justify to Left and Right Margins
Notice how all of lines are lined up with both the left and right margins.

Vertical Centering
Thetext is adjusted vertically to position it in the center of the screen.

Center Horizontally and Vertically
Thetext is adjusted horizontally and vertically to position it in the center of the screen.

e e i

| _).r
i~

Top Justify
Thetext is adjusted vertically so that the top row is placed at the top margin.

!

Ll |
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Bottom Justify
Thetext is adjusted vertically so that the bottom row is placed at the bottom margin.

[l

The“Row” section of the “Positioning Controls Window” (shown below) has four
buttons.

=}

These buttons are used to control individual rows of text. Each row can be centered
horizontally or justified to the left margin, right margin, or both margins at the same time.
To center arow, place the cursor on the row that you want to center and press the
“Horizontal Centering” button. The row is now centered horizontally between the |eft
and right margins.

To justify the row to the right margin, press the “Right Justify” button in the “Row”
section of the “Positioning Controls Window”. This moves the text to the right so that
itisaligned to theright margin. Pressthe“Left Justify” button in the “Row” section.
The text moves to the left so that it is aligned to the left margin.

To justify the row to both margins at the same time, press the “Justify to Left and Right
Margins” button in the “Row” section. Thefirst character of the row is placed at the left
margin, and the spacing between the characters is adjusted so that the last character of the
row is aligned to the right margin.

To perform the centering and justifying functions on al of the rows of text on the page,
use the corresponding buttons in the “Page” section of the “Positioning Controls
Window” (shown below).
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Try pressing the “Horizontal Centering”, “Right Justify”, “Left Justify”, and “ Justify
to Left and Right Margins” buttonsin the “Page” section. Notice that the functions are
now done to every row on the page.

Pressthe “Center Horizontal and Vertical” button (shown here) to center the entire
page both horizontally and vertically.
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Pressthe “Top Justify” button (shown here) to move the entire page to the top margin.

!

Fal |

Press the “Bottom Justify” button (shown here) to move the entire page to the bottom
margin.

[l

Press the “Vertical Centering” button (shown here) to center the page vertically between
the top and bottom margins.

>ifle
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Chapter 6 Logos

MediaCreator has the capability of displaying an independent logo, maximum size 256 X
128 pixels. Your logo graphic file can be placed in any directory of your PC (rendered by
your favorite windows graphic art program, scanner, or device).

All conversion and placement is accomplished by the “Configure Logo” menu choice
located under “Communications’. Y ou must be actively connected to your MediaXtreme
in order to access this menu.

Step 1) Connect to your MediaXtreme through the communications menu item

Step2) Click on....Communications....... Logo Configuration

The Logo Configuration window appears. Since you are actively connected, your logo
may be replaced and repositioned more or less real-time. The black graphic box indicates
the relative size and position of the active graphic when you connected.

To reposition your logo move the X and Y axis slide controls to the desired position.
Click on SET and the new positioning info will be sent to the MediaXtreme and the logo
will be moved.

Once SET is used the current page display will freeze until OK closes the menu and
allows the page presentation to resume.

To change your logo press Remove, the current logo is removed and adirectory dialog
box of your PC is presented. Y ou may now choose you new logo at the location you
stored it and it will be imported into the MediaCreator software for positioning and
sending with the SET function. Please note the following files are supported: .bmp, .tif

tga, .gif, .pcd, .jpg, -pcx

" Current Logo : PEACOCK _bmp

Hew | | Bemove |

" Poszition Adjustment
X: 546 Y- 394
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Chapter 7 Background Color Boxes

The MediaCreator can display background color boxes over the background image (or
external video) and behind the text. Each background color box can be positioned and
sized to anywhere on the screen. The color box can be set to a solid color, a smooth color
spread between the top and bottom of the box, a color gradient (afour or five point area
gradient, or alinear gradient with up to 16 colors), or afull color texture. If the
background color boxes have a solid color, a color spread, or a color gradient, the
transparency and background video levels of each color point can be adjusted.

As many as 32 background color boxes can be used on each page. Each background
color box is assigned to its own layer. The background color layers are aways behind
the text layer and in front of the background image. The priority that each background
color box is assigned determines how they will appear when one background color box
overlaps another. A background color box that has a higher priority will appear in front
of color boxes that have lower priorities.

To create or edit a background color box select the “Background-Colors” tab in the
Control Tabs window. The Background Color Box Controls (shown below) will be

displayed.
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Creating a New Background Color Box

To create anew background color box press the “New Background Color Box” button.
A new color box will appear behind the cursor row. The background color box begins as
a semi-transparent gray that is the full width of the screen, and the height of the cursor
row.

The cursor appears to surround the new background color box. The cursor has six cursor
handles. Three of these handles (on the left and bottom of the cursor) are used to position
the color box. The other three handles (on the top and right of the cursor) are used to size
the color box.
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Moving and Sizing Background Color Boxes

Use the handle at the top of the cursor to adjust the height of the color box. Usethe
handle on the right side of the cursor to adjust the width of the color box. Dragging the
handle on the upper right corner of the cursor will adjust both the height and width of the
color box.

Y ou can move the Background Color Box in any direction by clicking on the handlein
the lower |eft corner of the cursor and dragging the mouse. If you want to move the color
box horizontally only (without moving it vertically) use the handle on the left side of the
cursor. The handle on the bottom of the cursor will move the color box vertically
(without changing the horizontal position).

Changing Background Color Box Color

There are five different ways of selecting a color for the background color box. These
methods are as follows:

?? Color Picker

The color picker lets you select the color using a visual approach.

?? Color Sliders

The color dliderslet you select a color using a numerical approach.

?? Color Palette

The color palette lets you select a color from a palette of 64 (User Definable) preset
colors.

?? Color Gradient

A color box can be set to any of the 64 user-defined color gradients. These may be either
alinear gradient with up to 16 color points that can be rotated up to 90 degreesin either
direction, or an area gradient that can have four or five color points defined.

?? Color Texture

A color texture can be selected from any of the 4 textures that are currently loaded.
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Color Picker

Press the “Picker” button to display the color picker controls. The color picker controls
are shown below.
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The top and bottom of each background color box can be set to different colors. There
are two boxes to select whether we want to change the top color, the bottom color, or
both. If the top and bottom colors are different, the color box will be drawn with a
smooth color spread between the two colors. The top and bottom transparency and
background video levels can also be set independently.

Below these check boxesis an lllegal Color Indicator. If the selected color exceeds
NTSC or PAL limitations, this box will appear red to indicate that you have selected an
illegal color. Otherwise thisbox will appear green.

Below the lllegal Color Indicator isthe “Pick Color From Screen” button. Pressing
this button will change the appearance of the mouse cursor to look like an eye dropper.
Move the mouse to a position on the screen that you want to copy the color of, press left
mouse button and the color under the mouse will be selected.

To theright of these controlsisthe Hue Picker. Thisis used to select the hue (red,
green, blue, etc.) of the color. Place the mouse over this control, and press the left mouse
button to select the desired Hue. When the new hue is selected, the background box will
be redrawn with the new color, and the Color Picker Area (to the right of the Hue
Picker) will aso be drawn with the new hue.

Once the hue is selected you can now pick acolor. Place the mouse over the Color
Picker Area and press the left mouse button. Thiswill select the color under the mouse.
If you hold down the left mouse button while you move the mouse around the Color
Picker Area, the background color box will be redrawn with the new color each time
you select anew color by moving the mouse.

Y ou can aso control the Transparency of the color. The Transparency setting can
make the color fully opague, semi-transparent, or fully transparent. When acolor is
semi-transparent, the text component is drawn tinted over whatever is behind it. When
the color isfully transparent, it can’t even be seen on-screen. Setting the transparency
level to 0 makes the object fully opaque. Setting the level to full (255) makes the object
fully transparent. Any value in between, makes a color that is semi-transparent.

There are avariety of ways to change the Transparency level. Thelevel can be
increased by pressing the increase button to the right of the transparency number box. If
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you hold this button down, the level will continue to increase until you release the button.
To decrease this value, press the decrease button. Holding down this button will continue
to decrease the value until it isreleased. If you move the mouse over the transparency
number box, then press and hold down the left mouse button, you can change the value
by moving the mouse. Moving the mouse up or to the right will increase the value.
Moving the mouse down or to the left will decrease the value. When you have selected
the desired value, release the left mouse button.

The value of the transparency level can be entered directly. Do this by double-clicking
the transparency number box (thiswill highlight all of the digitsin the number), typein
the new value and press the enter key.

The color can be also mixed with background video. Setting the video level to avalue of
0 makes the object the selected color. Setting the video level to full (255) draws the
object with background video. Any value in between makes the object appear as
background video that istinted by the selected color. For some very interesting effects,
try blending colors, background video, and transparency over a background graphic
image.

The background video level can be adjusted in the same way as the transparency level.

Color Sliders

Pressthe “Sliders” button to display the Color Slider Controls. The Color Slider
Controls are shown below.

_F'n':k__er ¥ TopEalor e Red | —— ’— IE
T e e T
] | — O HLS —

Gradient | | LegsColor | ik iz iE
| F—— 1 ———— |

The top and bottom of each Background Color Box can be set to different colors. There
are two check boxes to select whether we want to change the Top Color, the Bottom
Color, or both the top and bottom colors. If the top and bottom colors are different, the
Background Color Box will be drawn with a smooth Color Spread between the two
colors.

Below these check boxesisthe lllegal Color Indicator. If the selected color exceeds the
NTSC or PAL limitations, this box will appear red to indicate that you have selected an
illegal color. Otherwise thisbox will appear green.

The MediaXtreme has two (2) numerical systemsfor defining colors. They are RGB
(Red, Green, Blue) and HLS (Hue, Luminance, Saturation). Both of these systems are
used to define the same thing (like yards and meters). Adjusting one will automatically
change the other. Y ou can select which method to use by pressing either the RGB or
HLS button. Y ou can switch back and forth between the 2 color systems at any time just
by pressing the appropriate button.
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The RGB and HLS values can be adjusted by dragging the sliders, or by double-clicking
the number box and entering the new value with the keyboard.

Color Palette

Pressthe “Palette” button to display the color palette. The Color Palette is shown
below.

Picker

IV Top Color

Slidets

i E'@ﬂu'rrrEEu[u'[
Faefie) |———

Gradient: : E Celor

Testures | BackgroundVideo| 5 e s e btton o modi

The preset Color Palette can hold 64 preset colors. These preset colors are displayed in
thiswindow. Not al of the preset colors can be displayed at one time, so thereisascroll
bar on the right hand side of the color palette entries. Use this scroll bar to scroll through
al of the preset colors.

The top and bottom of each Background Color Box can be set to different colors. There
are two check boxes to select whether we want to change the Top Color, the Bottom
Color, or both the top and bottom colors. If the top and bottom colors are different, the
Background Color Box will be drawn with a smooth Color Spread between the two
colors.

Below these two check boxesisthe lllegal Color indicator. If the selected color exceeds
the NTSC or PAL limitations, this box will appear red to indicate that you have selected
anillegal color. Otherwise this box will appear green.

To select acolor from the preset color palette, position the mouse over the desired color
and click the left mouse button. Y ou can change a color in the preset Color Palette by
double clicking the entry that you want to change. For more information about
modifying the preset Color Palette, see the section “Modifying the Color Palette” in
chapter 10.

Thiswindow also has a button labeled “Background Video”. Pressing this button will
set the color so that the Background Color Box will be drawn with background video.

Color Gradients

Press the “Gradient” button to display the color gradient selection window. The Color
Gradient selection window is shown below.
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Double Click on any Colar Gradient ta modify it,

64 color gradients can be defined for each project. The Color Gradients that are currently
defined for this project are displayed in thiswindow. Not all of the color gradients can be
displayed in thiswindow at one time, so thereisascroll bar on the right hand side of the
Color Gradient entries. Use this scroll bar to scroll through all of the color gradients
currently set for the project.

To select acolor gradient, position the mouse over the desired gradient and click the left
mouse button. The Background Color Box will then be drawn with the selected color
gradient. You can edit a Color Gradient, or build a new one, with the gradient builder.
To do this, double-click the Color Gradient that you want to modify. For more
information about using the gradient builder, see the section “Building Color Gradients”
in chapter 10.

Color Textures

Pressthe “Textures” button to display the Color Textures selection window. The Color
Textures selection window is shown below.

Picker = SENENENENES
IIE=NEIEEN
Sliders HEIENENEEINE
ﬁ . Mﬁwﬁ“'—“ﬁ””“ﬁ”mﬁ”' :
letie mENENMENEN=NE
— allEENENENEL
Bt SEENENENETE
e eEEIEETE=
i Diouble Click o ariy T esiure to modify it

8 full Color Textures can be loaded into the system at onetime. The Color Textures that
are currently loaded are displayed in thiswindow. The Textures are displayed large
enough so that you can easily see what the texture looks like. Not 8 textures can be
displayed in thiswindow at one time, so thereisascroll bar on the right hand side of the
textures. Usethis scroll bar to scroll through all of the textures that are currently loaded.
To select a Color Texture, position the mouse over the desired texture and click the left
mouse button. The Background Color Box will then be drawn with the sel ected texture.

Y ou can load a new texture by a double-clicking on the one that you want to replace.
When thisis done you will be asked to specify which graphic image you want to load as a
texture. For more information about |oading graphic images as Color Textures, see the
section “Loading Textures” in Chapter 10.
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Full-Screen Background Color

To create a background color box that covers the full-screen, pressthe “Full Screen
Background Color” button. A new background color box (that is a semi transparent
gray) will be created that covers the entire page.

Selecting Background Color Box

Y ou can only edit one background color box at atime. Before you can modify a
background color box you need to select it. The selected color box is displayed with a
cursor (rectangular box) around it. The cursor also has six small boxes attached to it.
These are called cursor handles, they are used to size and position the background color
box.

Background color boxes can be selected by clicking the mouse on the desired one. |If
more than one background color box overlap, keep clicking the left mouse button until
the one you want is sel ected.

Changing Color Box Priority

Each color background box is placed on its' own separate layer (behind the text layer and
in front of the background graphic image). The priority of each background color box
determines how it will appear when one color box is overlapped by another. The
background color boxes that have a higher priority will appear in front of color boxes that
have alower priority.

The background color controls have four buttons that are used to change the priority of
the background color boxes. These buttons allow you to move the background color
boxes in front of, or behind other color boxes when they overlap. These buttons are
shown below.

Press this button to move the current background color box to the highest
priority. When thisisdoneit will appear in front of al other background
color boxes.

Press this button to increase the priority of the current background color
box by one. Thiswill place the color box in front of the color box that
had the next higher level of priority (if they overlap).

Press this button to decrease the priority of the current background color
box by one. Thiswill place the color box behind the color box that had
the next lower level of priority (if they overlap).

Press this button to move the current background color box to the lowest
priority. When thisisdoneit will appear behind all of the other
background color of boxes.

I/«

Deleting a Background Color Box

To remove a background color box from the page, select the background color box that
you want to delete by positioning the mouse over it and clicking the left mouse button.
Onceit is selected, press the “Delete Background Color Box” button. Thiswill delete

the current background color box.

Keywest Technology 97
www.keywesttechnology.com

800-331-2019 (USA)



MediaCreator Software Operations Manual 290ct03
Keywest Technology MediaXtreme System rev4

Chapter 8 Background Images

The program can display either a graphic image or a background video source (provided
your system is capable of overlying titles over video) behind the text. The background
graphic can be in any of the following graphic formats:

Windows bitmap (BMP)

TIFF

Targa(TGA)

PCX

GIF

JPEG

3IIIIS

These are standard graphic formats that can be generated by many third party software
packages. If no background graphic image is selected, the text will be overlaid over the
background video source (if your system is capable of this).

A background graphic is displayed centered on the screeninits original size. When the
graphic is displayed with its original size, it may or may not fill the entire screen.

To change the background image, select the “Background - Image” tab In the Control
Tabs window. The Background Image Controls (shown below) will be displayed.

Tewt | Colors | Positioning | Row Spacing | Logos | Backgiound - Colars E‘hﬁfﬁgquihﬂ'ﬁﬂﬁgﬂ-l Page Trahsitions |

Curretit Backaraund Graphic Irmage:
|CAPCG_RFSABITHMAP Snow. BMP

Mo Graphic

: : Select Mew
[Background Vidso|

Background Graphic

No Graphic (Background Video)

Specia hardware or software is required to overlay the pages over video. Some systems
are not capable of this. If your system is not capable of overlaying on video, the
background will be displayed as black.

To overlay the title over background video, pressthe “No Graphic (Background
Video)” button. Any background graphic that may have been displayed will disappear
and the text will be displayed over the background video.
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Select New Background Graphic

To load agraphic, pressthe“ Select New Background Graphic “ button. A window
will appear asking you to Select the Background Graphic. Select the graphic image that
you want to load as a background and press the “Open” button. The selected graphic
will be loaded.

When you load a background graphic, the graphic may be smaller than the screen, the
same size as the screen, or larger than the screen. If the graphic is smaller than the
screen, it will be centered on the screen. If the graphic is the same size as the screen, it
will be displayed as a full-screen image. If the graphic islarger than the screen, the
center portion of the graphic will displayed. The edges of the graphic will not be

displayed.
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Chapter 10 Modes, Settings, and Adjustments

User Preferences

The* Set User Preferences” dialog box is used to set preferences that may vary from
one user to another. To change the user preferences select the “ User Preferences”
command from the “ Settings” menu. When thisis done the “Set User Preferences”
dialog box (such as the one shown below) will appear.

Set User Preferences
IF your display card will display ar image by - 'I?ypéT.’amHl‘.uquTeg-.tu__re Memom: — - Automatically Save Pages
writing & file to it-(such 5z the PR, enter " Alwaps Sutomatically Save
the Path and flename needed to display L b MBytes e
title graphic o the Display Card, Min 1 - Mar15 & Bl st
e pou press the "Rethiaw Page buttan,  Thizvalue specifies howmuch. | | £~ Naver Automaticaly Save
The mage wil be wilten to this s to dsplsy | 1EMaY [0 acsdn [a ‘Egﬁfﬂfﬁ'?’“f- =
the title on the Display Card zcreen. Thiz file. ggrlzséeiang ::tgr[reosr meszé - _';ftﬂ:,l : .
must have etfiera T G of BYiE extension. P ettty s M (¥ 480 Lines " 486 Lines
Erarmple: | Full! pou should increase thiz valus:

FATGANDISKONEOOTSPEG_SHOW. THA

I ok i Cancel |
The set user preferences dialog box is made up of the following controls.
Automatic Page Save mode Used to select the Automatic Page Save mode.
Typeface/lLogo/Texture Memory Used to set how much memory to use for the
setting Typeface, Logos, and Textures buffer.
Other Preferences Other preferences that are unique to the type of

hardware you are running the program with.

Automatic Page Save Mode

The program can only have one page open at atime. When you open a new page, the old
page (or any changes made to it) will be discarded unlessit is saved to disk. When you
open anew page, or exit the program, the current page can automatically be saved to disk
if it was changed.

?? Always Automatically Save

This setting will automatically save the page to disk (overwriting the original) without
prompting you. Use this setting with caution. Any changes you make to the page will be
saved to disk. You don't have the option of changing your mind.

?? Always Ask First

This setting will ask your permission before saving the page to disk. If you have not
modified the page, you will not be asked if you want to saveit.

Never Automatically Save
This setting will never automatically save the page. The program will not display the
“Automatically Save Pages” window when you open a new page.
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Typeface/Logo/Texture Memory Setting

When the program starts, it allocates a block of memory that is used to hold Typefaces.
This memory is aso used to cache data that is needed temporarily when composing
pages. If you allocate more memory for this, you will be able to load bigger Typefaces.
You will also get better performance from the program, but less memory will be available
for other applications.

If you are getting an error message such as“ Typeface/Logo/Texture Memory full” you
should increase this value.

Other Preferences

This box may also have other user preference settings that are unique to the type of
hardware or software you are running the program with.

Setting up Tabs

The program can set up to 16 tabs per page. The tabs specify horizontal positions of the
screen that are used to align columnar text. The tab positions are stored with the page.
When a page is opened, the tab positions will be set to those that the page was created
with.

To add, remove, or reposition atab, or to enable or disable the tab display, select the “ Set
Up Tabs” command from the “ Settings” menu. Thiswill display the “Set Up Tabs”
dialog box (shown below).

SET LUP TARS

b & NEW TAB select the tab position
I Display Tab Pasitions it e ot paskinh

TaMOVE A TAB, drag it to the desired position.

ToDELETE & TAB. select it ard press the Delete Tab butkan

[Clelete Tah Cancel

Display Tab Positions

The Tab Display shows the positions of the tabs that are currently set. If the tab display
isenabled, vertical lineswill appear the full height of the screen. Each one of these
vertical lines shows the position of atab that is currently set. Clicking the “Display Tab
Positions” check box will toggle the state of the Tab Display. If the Tab Display ison
(signified by a check mark), thiswill turn it off.

Markersin the set up tabswindow (below the title compose window) also shows the
current tab positions. These markers are displayed regardless of the “Display Tab
Positions” setting. Let’s call thiswindow the “Tab Markers Window”.

Once the tabs have been set up, they can be saved as the default tab settingsin a project.
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Set a New Tab

The Tab Markers window displays al of the tabs that are currently set. To set anew tab,
position the mouse in the Tab Markers window at the position that you want the new tab
and click the left mouse button. A new marker will appear at the mouse position to
indicate the position of the new tab.

Move a Tab

To move (reposition) an existing tab, position the mouse over the Marker that you want
to move and drag it to the desired position. Any text that is on the page will be redrawn
to reflect the new tab position.

Delete a Tab

To delete an existing tab, select the marker that you want to delete by moving the mouse
over it and pressing the left mouse button. The marker will turn red to indicate that it is
selected. Pressthe “Delete Tab” button. The selected marker will be deleted.

Safe title Margins

When transmitting a video signal to alarge number of televisions, many of those
televisions will not be properly adjusted. If you create afull page of text and try to view
it on one of these televisions, the text may be cut off on the left, right, top, or bottom of
the screen. When you broadcast text, you normally want everyone to be able to read it
(especidly if you are trying to sell them anew TV).

To solve this problem we define marginsthat it is safe to title within. The margins are set
by the factory to be at the recommended 10% height and width positions of the screen.

Y ou can change these margin positions. To do this select the “ Safe title Margins”
command from the “ Settings” menu. When thisis done the safe title margins dialog box
(shown below) will appear.

Safetitle Margins E
Top Margin Lett Marair Bight Marain Bottor Margin
I {Ciiépia 5 atentie Margine '
a |~ Fre A
[ — [132” | == Dane

T TSR T

Use the “Display Safe title Margins” check box to hide or display the safe title margins
on the screen. The safe title margins are displayed on the screen whenever the “ Safe title
Margins” window is displayed, regardless of the state of the “ Display Safe title
Margins” check box.

If you keep your text within thisbox it will bein the safetitle area. Use the arrow
buttons to move the safe title margins. Each margin (top, bottom, left, and right) has two
buttons that are used to move them.
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‘ Moves the margin up one scan line. Moves the margin |eft one pixel.

VA

! Moves the margin down one scan Moves the margin right one pixel.
line.

To set the margins to the recommended 10 percent height and width positions of the

screen, press the “Default” button.

Once the safe title margins are adjusted, press the “Done” button. Thiswill remove the

dialog box from screen. The safetitle settings are saved as one of the project settings.

Lower Third Mode

Quite often with titling an image, you want to keep the titles in the Lower Third position
of the screen. To do this, without needing to re-position every page, set the system to
Lower Third mode. This moves the top margin (as well as the page text) to the Lower
Third position. Any pages composed in this mode will appear in the Lower Third portion
of the screen. Centering a page in thismode will center it in the Lower Third area.

To change the Lower Third mode select the “Lower Third Mode” command from the
“Settings” menu. If the system isalready in Lower Third mode, the Lower Third mode
will be turned off. Y ou can also toggle the Lower Third mode by holding down the
<Ctrl> key while pressing the <T> key.

The current lower third mode can be saved as one of the default project settings.

Default Directories

The program allows you to put any filein any directory on any disk. This often resultsin
filesthat you can never find again. It is best to keep files of the same type (or the same
project) in the same directory. Default directories are abig help here. The system allows
you to set default directories for the different file types. The default directories, and the
type of filesthat default to these directories, are shown below.

1. Page Directory

2? Pages

2. Exported Graphics
?? Graphic images that are exported when you press the “Export Page” button.

3. Typeface Directory
?? Typefaces

4. PCX Image Directory
?? PCX format background images.

5. GIF Image Directory
?? GIF format background images.

6. Bitmap (BMP) Image Directory
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?? Windows bitmap (BMP) format background images.

7. Targa(TGA) Image Directory
?? Targa(TGA) format background images.

8. TIFF Image Directory
?? TIFF format background images.

To change the default directories, select the “Default Directories” command from the
“Settings” menu. When thisis done the “Default Directories” Dialog box (shown
below) will appear.

F'EIEIE_% iC:\MK\F‘age& Browse..

Exported Graphics: IC:\MK\F‘&QE& Brokse.. _
Trpefaces: iC:\MK\TYPEFﬂ«EE Browise;,, Ok |
Temporarny: iE:'\MX'\TEMF' Browse,. |

Directory for Temparar Power CG files: o
: ancel |
LA | T AMAPCS Brawse |
GIFE | CAMIAGIF Browse:,,
Bitmap [BMP |C:AMcABITMAR Biowse..
Targa [TGAL |CAMAATARGA Browse.
TIFF: | CAMATIFF Browse..

This dialog box displays the default directories and their current settings. The path can
be entered directly, or you can browse for the desired directory.

To enter apath directly, select the default directory entry that you want to change, and
typein the full drive and path. This should be in aform such as C:\PATH. When you
directly enter adefault directory, you must make sure that the path exists on the specified
drive.

To browse for the desired directory, pressthe “Browse” button next to the directory that
you want to change. When thisis done the “ Select Directory” dialog box (shown
below) will appear.

x|
= Current Directary:
= pages C:hpages:
£ M=Framo Bfea =
Cotat s
B :!
Cancel |
Help
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Use this dialog box to select the new default directory. The controlsin this dialog box do
the following:

?? Directories List

Use this control to select the default directory.

?? Drives

Selects the drive that contains the desired default directory.

?? OK button

Press this button when the directory is selected.

?? Cancel button

Press this button to cancel the directory selection.

When you are done selecting the default directories, pressthe “OK” button in the default
directories dialog box. If you want to cancel the changes you have made, press the
“Cancel” button.

Modifying the Color Palette

To modify the color palette, the color palette must be displayed. Y ou can display the
color palette by selecting the “Colors” tab in the Control Tabs Window and then pressing
the “Palette” button. Position the mouse over the color palette entry that you want to
change and double-click the left mouse button. When thisis done the “ Color Palette
Editor” window (shown below) will be displayed.

Color Palette Editor | ] I
— =
Red| —————— | [24 % Hue| = | G~
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| : |
Trang | | i':' g Wideo| | i':' g
............................................ 3 S i Fick Calar
ot 1 Transparént | Backagrotnd "-z"rdeujl foiitian

The color palette editor has two methods of selecting acolor. You can use either the

Color Picker or the Color Sliders. Theleft side of thiswindow shows a large sample of
the current color selection. To the right of the color sample, at the bottom of the window,
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isan lllegal Color Indicator. If the selected color exceeds NTSC or PAL limitations,
thisindicator will appear red to indicate that you have selected anillegal color.
Otherwise thisindicator will appear green.

At the top of the screen, between the Color Sample and the Color Palette, are the Color
Picker controls. These controlsinclude a“Hue Picker” and a“Color Picker Area”.
The hue picker lets you select the hue (Red, Green, Blue, etc.) of the color. Place the
mouse over this control, and press the left mouse button to select the desired hue. When
the new hueis selected, the Color Sample, Color Picker Area, and the Color Sliders
will be updated to reflect the new hue.

Once the hue is selected you can now pick the color. Place the mouse over the Color
Picker Area and press the left mouse button. Thiswill select the color under the mouse.
If you hold down the left mouse button while the mouse is moved, the Color Sample
and the Color Sliders will be updated to reflect the newly selected color.

Below the Color Picker Controls and the Color Palette Display are the Color Sliders.
There are two numerical systems for defining colors. These are RGB (Red, Green, Blue),
and HL S (Hue, Luminance, Saturation). Both of these systems are used to define the
same thing (like yards and meters). Adjusting one will automatically change the other.

Y ou can use either set of didersto adjust the color. When you use one set of didersto
change the color, the other set is automatically updated to reflect the change.

There are four waysto adjust the RGB, HLS, Transparency, and Background Video
levels. They can be adjusted by dragging the dliders. They can also be adjusted by
double-clicking the number box and entering the new value with the keyboard. To “fine
tune”’ the levels, use the increment and decrement buttons. The value will be increased or
decreased by one each time you press one of these buttons. These buttons will auto-
repeat if you hold them down. The values may aso be changed by clicking in the
number box and dragging the mouse.

To theright of the Illegal Color Indicator isa*“Transparent” button. Pressing this
button will set the transparency level to full (255). This makesthe color fully
transparent. Anything that you assign this color to will not be visible.

To theright of the “Transparent” button isa“Background Video” button. Pressing
this button will set the background video level to full (255). Anything that you assign
this color to will be displayed using background video.

To theright of the “Background Video” buttonisa*“Pick Color From Screen” button.
Pressing this button will change the mouse cursor to look like an eyedropper. Move the
mouse to the position of the screen that you want to copy the color of, and press the left
mouse button. The color under the mouse will be selected.

When you have selected the desired color for the color palette entry, you can select
another color to modify from the color palette. When you are done modifying the color
palette, pressthe “OK” button and the Color Palette Editor window will close.

Once the color palette has been modified, the changes must be saved with the project
settings. Otherwise, they will revert to the old settings when the project is opened again.

Loading Textures

The system has 16 dlots that textures can be loaded into. When you use atexture on a
page, the page keeps track of which textures are needed to display the page. If the
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textures that are loaded do not match the textures needed by the page, the correct textures
are automatically loaded.

To load anew texture, the texture selection window must be displayed. Y ou can display
the textures selection window by selecting the “ Colors” tabs from the Control Tabs
Window and then pressing the “ Textures” button. Position the mouse over the texture
entry that you want to load the new texture into and double-click the left mouse button.
When thisis done the “ Select Graphic Image to use as a Texture” window (shown
below) will be displayed.

Select Graphic Image to use az a Texture EE
Loak ir; | =5 Powercg j | ﬂ*{l Pl
= Bitmap

|1 Gif

- P

1 Prajects

] Typeface

e ) | O |
Files of tpe: |.-'1'-.Illmage Types :_] Cancel |

[ Openasz read-orly

Select the graphic image that you want to load as a texture and press the “Open” button.
The selected image will then be loaded as atexture.

Building Color Gradients

64 color gradients can be defined for each project. To modify a color gradient, the color
gradient selection window must be displayed. Y ou can display the color gradient
selection window by selecting the “ Colors” tab from the Control Tabs Window and then
pressing the “Gradient” button. Position the mouse over the gradient that you want to
modify and double-click the left mouse button. When thisis done the color gradient
builder (shown below) will be displayed.
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The color gradient builder has two major sections, the Color Selection section (on the
right) and the Color Point Placement and Selection section (on the left). The Color
Selection section is used to select the color of each point in the color gradient. The Color
Point Placement and Selection section is used to select which point that you want to
change the color of, and to change the position of the color points that make up the
Gradient.

The program can create two types of color gradients, Linear Gradients and Area
Gradients. A Linear Gradient can have as many as 16 color points and can be rotated up
to 90 degreesin either direction. An Area Gradient can have either four (4) or five (5)
color points. A four-point color gradient lets you define a different color in each corner
of therectangle. A five-point color gradient also lets you add a5™ color point inside the
Area Gradient. The 5™ color point can be moved to any position inside the gradient.

The color point placement and selection section has two tabs. Oneto edit Area Gradients
and the other to edit Linear Gradients. When the color gradient builder isfirst opened,
the tab that corresponds to the type of gradient that you are editing is selected. To change
the color gradient to the other type just select the other tab.

Area Gradients
The“Area Gradient” tab (shown below) is used to edit area color gradients.
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The top portion of this window displays the current color gradient. If it isafive-point
color gradient, two markers will appear. One above the gradient and one to the left of the
gradient. Theseindicate the position of the fifth point inside the gradient. Y ou can move
the inside color point by dragging these markers. Y ou can aso moved the inside color
point by clicking at the desired position in the color gradient in this window.

The Corners group is used to select the color point(s) of the Area Gradient that you want
to change the colors of. If the color gradient isa4 Point Area Gradient, four check boxes
will be displayed representing each corner of the gradient. If the color gradient isafive
point Area Gradient, an extra check box will appear which represents the inside color
point. When a color point is selected, the box is marked. Y ou can select more than one
color point to be changed. When you select a different color (in the color selection
section) all of the selected points will be set to the new color.

There are two buttons in the Spread Type Group that let you select whether thiswill be a
4 Point or a5 Point color gradient. If you select “ 5 point”, the positioning markers will
appear. A center check box in the corners group will also appear.

The“Apply Color to Selected Corners” button will set al of the selected color points
to the current color.

Linear Gradients
The Linear Gradient tab (shown below) is used to edit Linear Color Gradients.
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Linear Gradient | Area Gradient |

The Linear Gradient tab has three main controls. The control on the left (let’s call it the
Placement Control) displays the current position and color of each point on the Linear
Gradient. The top control displays the current Linear Color Gradient. The bottom
control (let’s call it the Angle Control) is used to set the angle of the Linear Color
Gradient.

The Placement Control shows positions and colors of the color points that are currently
set. A marker on the left side of the Placement Control represents each color point. You
can use this control to add a new color point, move an existing color point, delete a color
point, or to select a color point to change the color of.

Set a New Color Point

To set anew color point, position the mouse over the Placement Control where you want
the new color point to be and press the left mouse button. A new marker will appear at
the mouse position to indicate the new color point.

Move a Color Point

To move (reposition) an existing color point, position the mouse over the marker that you
want to move and drag it to the desired position.

Delete a Color Point

To delete an existing color point, select the marker that you want to delete by moving the
mouse over it and pressing the left mouse button. The marker will turn red to indicate
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that it is selected; all other non-selected markers will be blue. Pressthe <Del> key on the
keyboard, and the selected marker (and color point) will be deleted.

Change the Color of a Color Point

To change the color of acolor point, select the color point that you want to change the
color of, by moving the mouse over its' marker and pressing the left mouse button. The
marker will turn red to indicate that it is selected. Use the controlsin the Color Selection
section (on the right hand side) of the Color Gradient Builder.

Rotating a Linear Gradient

Use the angle control to rotate the Linear Gradient. The angle control indicates the
current rotation angle of the gradient with the line that isin the half circle. If the gradient
isvertical, the indicator linein the half circle will be vertical. If the gradient isangled to
the right, the indicator line will go off to the right, and so on. Y ou can rotate the Linear
Gradient by clicking the mouse within the half circle. You can also drag the rotation
angle by dragging the indicator line back and forth. Asthe rotation is changed the color
Gradient Indicator (above the angle control) is redrawn to display the new angle of
rotation.

Selecting a Color for the Color Point

Once you have selected which point(s) that you want to change the color of, use the
Color Selection controls (on the right hand side of the Color Gradient Builder) to select
the new color. The Color Gradient Builder has three methods of selecting acolor. You
can use the Color Picker, the Color Sliders, or the Color Palette.

At the top of the screen, on the left-hand side of the color selection section, are the Color
Picker controls. These controlsinclude a“Hue Picker” and a“Color Picker Area”.
The hue picker lets you select the hue (Red, Green, Blue, etc.) of the color. Place the
mouse over this control, and press the left mouse button to select the desired hue. When
the new hueis selected, the Color Gradient, Color Picker Area, and Color Sliders will be
updated to reflect the new hue.

Once the hue is selected, you can now pick the color. Place the mouse over the Color
Picker Area and press the left mouse button. Thiswill select the color under the mouse.
The Color Gradient and the Color Sliders will be updated to reflect the newly selected
color. If you hold down the left mouse button while the mouse is moved, the color under
the mouse will be selected as the mouse is moved.

To theright of the Color Picker controlsisthe Color Palette. The Color Palette has 64
preset colors. Not all of the preset colors can be displayed at one time, so thereisa scroll
bar on the right hand side of the Color Palette. Use the scroll bar to scroll through all of
the preset colors. To select a color from the Preset Color Palette, position the mouse over
the desired color and click the left mouse button. When a color is selected from the color
palette, the Color Gradient, Color Picker Area, and the Color Sliders will be updated to
reflect the new color.

Below the Color Picker controls and the Color Palette display are the Color Sliders.
There are two numerical systemsfor defining colors. They are RGB (Red, Green, Blue)
and HL S (Hue, Luminance, Saturation). Both of the systems are used to define the same
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thing (like yards and meters). Adjusting one will automatically change the other. You
can use either set of dlidersto adjust the color. When you use one set of slidersto change
the color the other set is automatically updated to reflect the change.

There are four ways to adjust the RGB, HLS, Transparency, and Background Video
levels. They can be adjusted by dragging sliders. Double-clicking the number box and
entering the new value with the keyboard can also adjust them. To “fine-tune’ the levels,
use the increment and decrement buttons. The value will be increased or decreased by
one each time you press one of these buttons. These buttons will auto-repeat if you hold
them down. Clicking on the number box and dragging the mouse may also change the
values.

This section includes an lllegal Color Indicator to warn you if the selected color exceeds
NTSC or PAL limitations. The lllegal Color Indicator will appear red if you have
selected anillegal color, otherwise it will appear green.

To theright of the Illegal Color Indicator isa*“Transparent” button. Pressing this
button will set the transparency level to full (255). This makes the color fully
transparent. This portion of the color gradient will not be visible. You will seewhat is
behind it on screen.

To theright of the “Transparent” button isa“Background Video” button. Pressing this
button will set the Background Video level to full (255). This portion of the color
gradient will be displayed using Background Video.

To theright of the “Background Video” buttonisa*“Pick Color From Screen” button.
Pressing this button will change the mouse cursor to look like an eyedropper. Move the
mouse to the position of the screen that you want to copy the color of, and press the left
mouse button. The color under the mouse will be selected.

Once you have finished changing the color of the selected color point(s), you can select
another color point to change the color of.

Final steps

When you are finished creating the new Color Gradient (or modifying an existing
gradient) pressthe “OK” button and the Color Gradient Builder window will close. Any
changes to the color gradients must be saved with the project settings. Otherwise they
will revert to the old Color Gradients when the project is opened again.
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Chapter 15 Page Transitions

When pages are shown ON AIR through the MediaXtreme, each page can be displayed
with some sort of page transition. There are anumber of different Page Transition Types
to choose from. Y ou can control how long the Page Transition takes by setting the
Transition Duration. Each page can be set to different Transition Type, Transition
Duration, and Dwell Duration. Thisletsyou intermix different transition types and
durations in a sequence of pages. One page can roll onto the screen fast, and the next
page can wipe on slowly.

These three page attributes (Transition Type, Transition Duration, and Dwell
Duration) are saved with the page. Be sure to set the page attributes before saving the
page.

These page attributes only apply to the pages when they are displayed using the
MediaXtreme with its unique hardware.

To set the Page Attributes, select the “ Page Attributes’ tab in the Control Tabs Window.
The controls for setting the Page Attributes will then be displayed as shown below.

Texl I Enlm&! Psiticmirig | ‘Row Spag:ingi Backigroind - ED|I:IT$| Backagrotirid - Imagel Widen Window Fage Attibutes l

s [rate " alidity - Braps af the Week -
Trarsition: |Pesl Four Quadrants | & e Flee || F ol
Dl |5 Sentnds St Date E '_“'_'I"'”:"-"-’
[MesR ~] g =] |20 = | =
Add Tokens | | ER D — 1 5 T
Pl =
= (N [l B R el e [ T l"]'?l ;i I1": ;i I"' ;i 7

Page Transition Type

There are 70 2D and 3D transitions for the MediaXtreme.

The Page Transition Type drop down box displays the current transition type. It isused
to select the new transition type. The drop down box lists every category of transition
type available. Selecting thisfrom the list will select this as the transition type.

Once aPage Transition type is selected, it will appear in the Page Transition Type box.
For adetailed description of each Page Transition type, see the section Transition Types
later in this chapter.

Dwell Duration

The Dwell Duration specifies how long the page will remain on the screen when
automatically sequencing pages. The duration is specified in seconds

To change the Dwell duration, select the Dwell Duration box (using either the keyboard
or the mouse) and enter the new value.
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Chapter 16 Exiting the MediaCr eator

When it stime to exit the MediaXtreme, select the “Exit” command from the “File”
menu. The program will begin its shut down sequence. The program can also be exited
by holding down the <Alt> key while pressing <X>.

Any page changes or settings changes that are not saved will be lost when you exit the
program.

If the page has been modified, and the “ Automatically Save Pages’ setting in the “User
Preferences’ dialog box requiresit, the following message will appear.

Automatically Save Pages I

Do pauwant o save
‘the chaniges to the
curent page?

IF-vou dor't want the sestemio keep
-asking wourthis question; use the
"Iser Preferehces" commiand in the
"Setup!” menu to change the:
“Eutomaticalie Save Pages' setings.

If you want to save the changes to the page, press the <Y es> button, otherwise press the
<No> button and the changes will be discarded.

We hope you have enjoyed using the MediaXtreme, and get many, many more years of
successful use from it!
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CHAPTER 17 Optional Components

Local Internet Weather Setup and Operation Manual

The Local Internet Weather option allows you to display basic local weather parameters
on your MediaXtreme Pages and Crawls (parameters listed below in variables table).
Without purchasing a full weather instrument hardware package, you can still bring basic
datato your viewers. The following describes setup and operation of this optional
component. If you purchase the option when you purchase your unit, installation will
already be accomplished at the factory, but you will still have to perform the setup to pick
your location.

Setup Instructions:
First you must send the setup executable over to the MX Player:

(1) Connect to the MX.

(2) Select Send File; Select LIWSetup.exe on the Install CD; when prompted about
where to place the file on the M X, Enter C:\

(3) Disconnect from the MX.

Connect aKeyboard, Monitor and Mouse to the MediaxXtreme, and reboot the M X.
After the MX has rebooted and a schedule has started to play, pressthe letter ‘Q’ on the
keyboard to access the MX player’s desktop:

(1) Double click on My Computer icon and select MediaXtreme (C:)
(2) Open C:\ Drive and click LIWSetup.exe. Follow theinstall prompts. Reboot the
MX once more.

After the MediaXtreme has rebooted, Press the letter Q' on the keyboard. Now you will
set up your Local Internet Weather location through the LIW application.

(1) Double click onthe My Computer icon on the desktop; select MediaXtreme (C:)

(2) Openthe‘LIW Folder; Double click on the LIW.exe application. The application
should now be open, but it will be minimized at the bottom of the screen in the
taskbar. Click onit to open it.

(3) You should see the following:

“ Local Internet Weather = [m] 4

File

| Local Internet VWeather DATA:
HMZI D7 TEE3Z SH008KT 105M EEWDRT 1541 42935

(4) Click on File and select * Setup Location...’
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* Local Internet Weather
File

Sebup Locakion, .,
S =TT = = T

MG 0716532 S4000KT 105 FEADR0 1901 42995

i ml .4

(5 Now you will be prompted with a series of screensto set up your Local Internet

Weather.

Select Location Wizard “ml

Welcome!
to Local Internet Weather Location Wizard!

Please click nextto cortinue: ..

¢ A et s

Select ‘Next >>' to move the next screen.
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Select Location Wizard

Plages seleit a country:

Swraziland ;I
Sweden
Swyitzerland

Syria

Taiwan

Tailkistan

Tanzanis

Thailand

Togo

Tonga

Trinidad and Tobago
Tunisig

Turkey

Tuvalu

Ugards

Ukraine:

United &rab Emirates _J
United-Kingdam

EI_Iru'rte:-:i States

Unitec States

ccBack [ mews>s | Concal

Select the Appropriate Country. The software Defaults to the United States.
Select ‘Next >>* when you are ready to move on.

Select Location Wizard

Mowy, please select & provincesstate:

United-States; AL

<4 Back | Hent s I Cancel |

Now select the corresponding State. Select *Next >>" When you are
Ready to continue.
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Select Location Wizard 3

Finsily, plesse select = cityt

KGCK Garden City, arden City Regional Alrport :I
AHGLD Goodland ; Renner Field

WHLC Hill Sity, Hill Sty Municipal &irport

KHUT Hutchinzon, Hotchinson Municipal Aifport

KHYS Hays Municipal &utomatic Westher Ob=erving ¢ Repotting System
JHIAB Moconnell Air Force Base

KICT WWichita, Wichita Mid-Cortinert Adrport

HIKE Olathe, Metw Century Sircenter

KLBL Liberal Municipal Automatic Weather Theerving f Reporting System
AHLWC Lawrence, Lawrance Municipal Lirport '
FhiHI Manhattan, Manhattan Municipal Lirpoit

) the Ja oty i
kP28 Medicine Lodge, Medicine Lodge
AHPPF Parsons, Tri-City Alrpor

KPTT Pratt Municipal

KREL Russzell, Russel Municipal Airport

FELM Ss_ulina', Saling Municipal Airport _"‘_I

United States, KSkERM Wichita, Colonel dames Jabars Airport

%< Back I Mest 32 I Cancel

Select the Airport that is closest to your location. Press ‘Next>>' to
Continue.

Select Location Wizard -

Thianik, you, T WeriTy wur-@:hi:’fuj}_}i:-_:&l_pwaﬂd ]:I['r_::_k finiéhg&ﬁ! it y_ﬁyﬁﬁi&.-satb’aﬁé&
st it Otfrerwize, click back to change your selections

¥ Maike thii: IDcation the datattt wiven | FUR THIS proGram nesd time

United States, KSHOIS Glathe, Johngon County Executive Sirport:

44 Back I Firitzk I Cancsl

Please Verify your choice and select check the box so you will not have to go through
this setup again. Click on the
‘Finished’ button when you are ready.
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Now that you have setup your Local Internet Weather, close the application. Make
sure the MediaXtreme can access the World Wide Web. If you cannot access the
Internet, Please contact your Network Administrator for further assistance. After you
have set the Internet up, restart the MediaXtreme. Now move over to the Media
Creator side.

Updating the Media Creator software

(1) Make sure the Media Creator software is not running.
(2) Run the MC Setup.exe off of the Local Internet Weather Setup disk. This
application will set everything up for you.

Operating The Local Internet Weather

Nothing will change with the operation of the Media Creator. The only additions are 19
new variables. They are listed below:

Wind Gusts US=#10

Wind Gusts Metric=#1 1
Wind Gusts MPH=#I2

Wind Direction Compass=#13
Visibility Kilometers=#14
Visibility Miles=#15
Barometer Metric=#16
Barometer US=#17
Temperature Celsius=#18
Temperature Fahrenheit=#19
Dew point Metric=# A

Dew point US=#IB

Wind Speed MPH=#IC
Wind Speed Knots=#1D
Wind Gusts Knots=#lE
Wind Direction Degrees=#IF
Location=#G

The figure below shows you how to insert avariable. Once you have inserted avariable
you will only see the #1 Code on the Media Creator. When the page is displayed on the
MediaxXtreme it will be updated with the correct Weather information.

Keywest Technology 119
www.keywesttechnology.com

800-331-2019 (USA)



MediaCreator Software Operations Manual

290ct03

Keywest Technology MediaXtreme System rev4

s

Grab T:

Attribul

.é-.ppl_l,l T

Attt

— 1

l ; l : Ressl

S L {=1al]

I b Spaci

Cente

Foi

Cerite

Barameter U5 - Page

Conditions Metric 7
Conditiohs LIS

D ewipaint Metric

Diewpaint LIS

Location Aedditio

Temperature Celsius whreme

Temperature: Fahrenheit Featir

Wisibility Eilometers
Wizibility Miles

Wwhnd Direction Compazs
whind Direction Degrees

TFext 1
B ackaroirnd - Image

Add Mew
Weariable

Colors

Keywest Technology

Wwind Gusts Knigts
Wind Gusts Metric
Wwind G rMEH
Whnd Gusts US

Wind Speed Fnots
“wWind Speed MPH

T emperature Fahrenheil

L]

www.keywesttechnology.com

800-331-2019 (USA)

Logos 1 Eackground- Color Bozes i

“indow Edge Color ] Page &ttibutes I
r—After Substitation is made: 1
= Leave Row asis

Center the Raow.
Laft dustif the o
Fight Jdustify the Raiw.
Left-and Right dustifp the Bow:

M

120



MediaCreator Software Operations Manual 290ct03
Keywest Technology MediaXtreme System rev4

10-Instant Alert Folders Option

The 10-Instant Alert Option replaces the EMERGENCY FOLDER function in the
MediaXtreme. It does so by giving you 10 instantly accessible folders. Y ou can use any
one of them, or al of them as emergency folders. Y ou could also use them asjust 10
folders you want to quickly call up.

There is anumber of applications for thisoption. Since afolder only hasto contain 1
page, for example, you could make a*“ Snow Day” page/folder, and a“Heat Day”
page/folder, and a“Boil Order” and a*“ Severe Thunderstorm Warning” page/folder (or
whatever is common for your area). Y ou could then, from the comfort of your own home
Internet connection, connect to your running MediaXtreme (that you’ re watching on your
local cable system public access channel), and activate any one of those pages instantly.

Thisis probably the least appreciated but most valuable option you could purchase. Just
imagine the possibilities.

How it works;

Select ‘ Add Page Folder Event’

HXNE Srheduls

(e T _ i |
S o (F el T vemd Disleieiv |
—_dtimpfe | _DekmEead |
Dle Vs |
ul Cored

Thisisthe same as the 1 Emergency Folder, but now there are 10 options to choose from.
Highlight afolder and select which Instant Alert Folder you want.

Keywest Technology 121
www.keywesttechnology.com
800-331-2019 (USA)



MediaCreator Software Operations Manual 290ct03

Keywest Technology MediaXtreme System rev4
BT x|
- Bof whls Fage Frewrrr Aihnes

3G —— 7 ey ol Fiimie
S e )
EHERG S | W P s P | |
EHEAGE : ]
EMERGT gy ¥oss
EMERGE FiRERTF"E TRARFE
EMEAGY
":E:{l" Srapt T BRI
PROMO 0 X -afim = F'?s b [E |

[ st Bage Sy

INETANT ALERT

O nlEArs Rt T Ihaant s rolds 6

O el Al e T Al A Fdisy 7

C IR Al Foier s iandant AR Faddsr 4

T b Al S E T nernt AR Folieg

U T T ST T

T8 I Camel J

After you send you updated schedule over to the MediaXtreme, you will be able to access
every folder instantly when you are connected.

Commmeatom Folder 1

L o bon Sphnay

fﬂl'l'lll'-'i!l In MA-ONF FCI'd'EJI'E

Folder 3

Falder 4

w FDId_E'r 5

T , Folder &

Bl ’ Folder: 7

R T Foldet &

e Folder 9

m.rnm FI:I|d'EJI' 1o

Resiime Schaduls

Under the INSTANT ALERT option you have 10 folders to pick from. There will
always be 10 options even if you only have 3 Instant folders scheduled. If you select a
folder that is not scheduled you will get a message telling you that there is not an Instant
Alert Folder scheduled for that specific folder.

BACKGROUND IMAGES

Thumbnail images of the included background graphics follow. Note that not all
customers will receive al of the shown images.
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Technical Support:

Keywest Technology Technical Support standard hours are 8:00 AM to 6:00
PM Central Time.

Our Technical Support Number for Registered users is:

800-331-2019

Unregistered Users Dial:

913-492-4666

After Hours Support Available—Follow Instructions at the Above Numbers.

On-Line Support Available at www.mediaxtreme.tv

5B AIM:  Keywest_Xtreme

w7 Yahoo: Media_ Xtreme

i MSN: tech@keywesttechnology.com

3E ICQ: 113986832

2 Email:  tech@keywesttechnology.com
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KEYWEST TECHNOLOGY
LIMITED WARRANTY

KEYWEST TECHNOLOGY does hereby declare that the said product be
covered under limited warranty for defective materials and workmanship. This
warranty is extended to the original purchaser only, for the amount of time
indicated below, effective from the original purchase date and subject to the
following:

*THIS WARRANTY DOES NOT COVER****

A. Products that have been subjected to abuse, accident, alteration,
modification, tampering, negligence, misuse, or if repaired or attempted
repair performed by anyone other than a service facility authorized to
render such service, or if the model or serial number has been altered,
tampered with, defaced, or removed

B. Operational adjustments covered in this manual

WARRANTY PERIOD: 1 Year Parts & Labor
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Register On-Line or copy this page and mail

PRODUCT WARRANTY REGISTRATION

Complete and mail within 10 days of purchase

Purchaser's Name

Title: Phone:

Company Name:

Address:

City: State: Zip:

Purchased From:

Comments:

PURCHASE DATE: MO. YR.
MODEL # SERIAL # PARTS LABOR

| | | 2YRs. 2 YRS.
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